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This beautiful 3D artwork
from Andrei Lacatusu
combines basic modelling
in 3ds Max with extensive
post-production in
Photoshop to make the
image really shine. Find
out how he did it in our

feature on p26.

APRIL MADDEN
Editor

orking with 3D is generally
something you expect to do
outside of Photoshop. However,
with Adobe teasing new 3D features
in Photoshop CC in addition to the ever-advancing
toolkit that's already present, more of the 3D
pipeline than ever before is being pulled into our
favourite program. On p26, professional 3D artists
share their tips and techniques for working with 3D
using Photoshop. You can find out how our beautiful
cover was created and get all the files you need to
make it yourself - no 3D software required!

Elsewhere in the magazine, Photoshop expert
Andre Villanueva explains how you can use shapes,
layers and masks to create a classic displacement
effect on p44, while artist Joe Roberts shows you
how to use ordinary photos of buildings and scenes
to build up an incredible sci-fi cityscape on p54.
Meanwhile, retouching master John Ross explains
how to tum an ordinary portrait photo into a

superhero movie poster on pé2. On pé8, we round up
a selection of 25 of the best quick fixes for Photoshop
professionals, helping you to speed up your workflow
and save yourself time with useful advice from
industry experts. Plus, you can learn how to add
some real-world texture to your Photoshop art by
creating your own watercolour textures and brushes
with the project on p90.

As ever, we're also showcasing some of the best
Photoshop talent out there. On p10 we take a detailed
look at the inspiration behind Natalie Shau’s eerily
beautiful works, while on p86 reader and professional
concept artist Riyahd Cassiem shares some of the
secrets of his success. Check out fresh young
Swedish design studio Krippa Design on p18, and
discover how artists Bartosz Kosowski, Frank Att,
Raphael Jiya and Matheus Lopes (aka Mathiole)
created some of their incredible works. Plus there's a
huge selection of fantastic creative resources for you
to use on FileSilo. Enjoy the issue!
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PHOTOSHOP PRO PANEL

MEET THE PROFESSIONALS SHARING THEIR PHOTOSHOP
EXPERTISE AND TECHNIQUES IN THIS ISSUE

ANDREI LACATUSU

andreilacatusu.tumblr.com
Time is of the essence when you work on a project, and to be as efficient as possible, you should start by using the keyboard shortcuts as

much as possible. | also set up additional shortcuts for many other tools, filters and commands, such as Gaussian Blur, Smart Sharpen,
Save for Web or plug-ins that | often use.
M Discover how Andrei Lacatusu combines 3D and Photoshop in the complete guide to 3D, starting on p26

© Andrei Lacatusu

Photography: Cristian Rubén
Retouching: John Ross

JOHN ROSS

www.theartofretouching.com
Whenever you feel overwhelmed

with too many complex tasks, stop

looking at everything at once, and

simply focus on smaller goals. It's

the details that will help keep you stay on track to r
finish, and not feel the burden of too many things at /

once. Small victories will help you solve one problem

at a time, until you reach completion.

B Learn more about John Ross's image-editing g
techniques in his movie-style tutorial on pé2

006



The magazine for Adobe® Photoshop” professionals
Imagine Publishing Ltd
Richmond House, 33 Richmond Hill,

Boumemouth, Dorset, BH2 6EZ
+44 (0) 1202 586200

AND RE Vl LLAN UEVA Web: www.imagine-publishing.co.uk

www.000-000-0000.com www.advancedphotoshop.co.uk
Just as an astute chef masters all culinary tools to be able to focus on ultimate e R e
flavour, you should strive for dominiation over every facet of Photoshop. Learn Magazine team
. oot Editor April Madden
shortcuts for tools and commands. Know the filters and blend modes. Familiarise aprilmdden@maging-pubishing.coak
yourself with menus and options and settings. As you gain proficiency, you'll have 01202 586218
more and more time to just create. Editor in Chief Amy Squibb
B Get creative with Photoshop's tools as Andre Villanueva walks you through creating a Production Editor iRebeoon Greg
_ Designer Rebekka Hearl
displacement effect on p44 Photographer James Sheppard
Senior Art Editor Duncan Crook
Andre Villanueva Publishing Director Aaron Asadi
Head of Design Ross Andrews

Contributors

Julie Bassett, Andrei Lacatusu, Larissa Mori, Kirk Nelson,
Joe Roberts, John Ross, Kenneth Shinabery, Andre
Villanueva and Poz Watson

Advertising
Digital or printed media packs are available on request.

Head of Sales Hang Deretz
01202 586442
hang.deretz@magine-publishing.co.uk

Advertising Manager Alex Camegie
01202 586430
alex.camegie@magine-publishing.co.uk

FileSilo.co.uk

Assets and resource files for this magazine can be found on
this website, Register now to unlock thousands of useful files.

Support: filesilohelp@imagine-publishing.co.uk

Iinternational

Advanced Photoshop is available for licensing.
Contact the International department to discuss
partnership opportunities.

Head of International Licensing Cathy Blackman
+44 (0) 1202 586401
licensing@magine-publishing.co.uk

Subscriptions
For all subscription enquiries:
adphotoshop@servicehelpline.co.uk
UK: OB44 B48 8402
Overseas: +44 (0) 1795 592 B8O
13-issue subscription (UK) - £62.30
13-issue subscription (Europe) - £70
13-issue subscription (ROW) - £80

Circulation
Head of Circulation Darren Pearce
01202 586200

Production
Production Director Jane Hawkins
01202 586200

Finance
Finance Director Marco Peroni

Founder
Group Managing Director Damian Butt

Printing & Distrnibution
Printed by: William Gibbons & Sons Lid, 26 Planetary Hoad,
Willenhall, West Midlands, WV13 3XT
Distributed in the UK & Elre by: Marketforce, Blue Fin Bullding,
110 Southwark Street, London, SE1 0SU
0203 148 3300
Distributed in Australia by: Network Services (a division of Baver
Media Group) Level 21 Civic Tower, 66-68 Goulburn Street,
Sydney, New South Wales 2000, Australia
+61 2 B6GT 5288
Distributed to the rest of the world by: Marketforce,
Blue Fin Building. 110 Southwark Street, London, SE1 0SU
0203 148 3300

Disclaimer

The publisher cannot accepl responsibility for any unsolicited
material lost or damaged in the post. All text and layout is the
copyright of Imagine Publishing Ltd. Nothing in this magazine
may be reproduced in whole or part without the written
permission of the publisher. All copyrights are recognised
and used specifically for the purpose of criticism and review.
Although the magazne has endeavoured to ensure all
information is comect at time of print, prices and availability
may change. This magazing 15 fully indéependent and not
affiliated in any way with the companies mentioned hergin.
Photoshop is either a registered trademark or trademark

of Adobe Systems Incorporated in the United States and/

or other countries and is used with express permission.

All % prices are US Dollars unless otherwise stated.

If you submit material to Imagine Publishing via post.
email, social network or any other means, you automatically
o £ e . Y o A _ . ET L grant Imagine Publishing an irrevocable, perpetual, royalty

Time is of the essence when VOU WO kona project oo liouwes o use e Inagss woroes Re snthe porthk,
i - e —~ ) i _ e : - . i in print, onliné and digital, and to deliver the images o
o A Y A A R e N T 3 .. i O R by existing and future clients, including but not limited to
and to be as efficient as possible, you should start by internationa lcensees for eproduction i termations.
i licensed editions of Imagine products. Any material you
submit is sent at your risk and, although every care is taken,

using the keyboard shortcuts as much as possible neiher imagine PLblishing o s empioyees, agents o
2 subcontractors shall be liable for the loss or damage.
ANDREI LACATUSU / ANDREILACATUSU.TUMBLR.COM

© Imagine Publishing Ltd 2015
ISSN 1748-7277

s
.

007



B EYEONDESIGN INDUSTRY NEWS

008

SLASHTHREE

RELAUNCHES

THE INTERNATIONAL ART COLLECTIVE PRESENTS
AN EXCITING NEW VISION ALONGSIDE ITS
LATEST PROJECT, DISCOVERY

ith over 100 core artists from 42

and almost 11,000 supporters,
Slashthree is definitely an artist platform
to be aware of: empowering creatives of multiple
disciplines to network, push their capabilities further,
and gain recognition on a global scale.

“The collective was formed as a response to a gap
in the online digital art community,” remembers
Tariq Adawi, who founded Slashthree in 2007. "There
were many outlets for creatives to share their work,
but they consisted of largely isolated experiences
that didn't provide informative and constructive
critiques. Even fewer outlets were facilitating any
form of collaboration or sharing between individuals,
and we felt this largely deprived artists of a valuable
experience through which they could grow. At the
time, we knew we wanted to create something that
would help us all grow together.”

The site was ulitmately launched complete with a
discussion forum to help artists develop their skills

_‘,F \
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Discovery exhibitiontacki®the interattiop
between emotion andscience

Tariq Adawi, Founder of Slashthree

countries, more than 2,600 submisisons,

with each other, and the community took off faster
than Adawi could have ever imagined. On the eve of
the international art collective’s 3,000th day of
operations, Slashthree relaunched with an updated
platform, vision, and new online exhibition called
Discovery, filled with all the high quality art,
illustration, music, and photography that the
collective is best known for.

With a focus on detailling their journeys as artists
and who they ve become since joining the collective,
the Slashthree core crafted over fifty unique
submissions to prepare for the launch.

“The concept of Discovery came from
challenging our understanding of who we are -
both as individual artists and as a collective,”
explains creative director Husam Elfaki, who
designed Slashthree’s newly updated platform.
Through it, the collective hopes to propel its artistic
presence to even more of an all-time high with new
elements such as heavy involvement in real-world
projects and causes.

"We found that our new perspective on Slashthree’s
future was a big opportunity for introspection,” Elfaki
continues, “so we wanted artists to confidently share
their identity through craft. There's something
extrermnely powerful about revisiting your own
personal trajectory over time and documenting that
journey, so we wanted to capitalise on that in the
most compelling way we could.”

Works for the exhibition, which will be
Slashthree’s 22nd to date, are both created by
veteran members Neil Hanvey, Benny Brand,
Anthony Giacomino, and newcomers Conrado
Salinas, Brock Hofer, Chris Connors, as well as
many others. With the addition of nine of his
elegant works, though, it was longtime member,
digital artist Isaac Burton who ultimately stood out
to the collective as being Discovery's featured artist.

To take part in Slashthree's new evolution, be sure
to apply as artist to the collective’s core at
artistcenter.slashthree.com/application/new, or
learn more information and take a peek at the art of
Discovery at www.slashthree.com.

At the time, we knew we wanted to create something
that would help us all grow together 3

Beekeeper by Isaac Burton: Burton's workflow initially
starts with paEer and pencil, completing several quick
composition sketches before doing a more full drawing
with all the outlines and basic shapes in place. This
then gets photographed and brought into Photoshop

B LOOKING INTO THE FUTURE

So far the relaunch has been very well received,
setting up the groundwork for more projects for
Slashthree - allowing both Adawi and Elfaki to
start looking to the future. “The new launch is
our first step in a path towards more tangible
success for our collective's artists, says

Elfaki. "While Discovery was about

allowing artists to express their
personal stories, our new
platform hopes to further
amplify the artists to a much
greater extent than ever
before. In doing so we hope to
use our skills to highlight
real-world issues and causes in a
way that only art can do.”

“Art is one of the most valuable pieces of
the human experience, and our ultimate goal
with this release was to redefine Slashthree as a
group that uses art to inspire positive change
and self-reflection,” adds Adawi. “In pursuing

S .
] j

this goal we believe we can make a difference
simply by doing more of what we love and
continuing to share it with the world.”

The team have already begun to promote
exclusive content including imited edition print
giveaways to anyone inspired by Slashthree, and
are excited to pull together plans that will give
back to the creative community through
resources, materials, and insights exclusively
from the Slashthree collective.

Slashthree s relaunche




BRAM VANHAEREN SHOWS OFF
THE #ANIWALL PROJECT

AN ADOBE 25 UNDER 25 WINNER HAS NOW PUBLISHED
AN EXCITING NEW PORTRAITURE PROJECT

At only 24 years old, Digital Artist Bram
Vanhaeren was estatic when he recently
learned he'd been selected for Adobe’s 25
under 25: a campaign launched to celebrate
Photoshop's 25th anniversary where a search
was officially launched for the best creative
visual artists around the globe that were under
25 years old.

Originally from Antwerp in Belgium,
Vanhaeren has now been using Photoshop for
ten years. °| didn't understand a single word of
English when | started working with
Photoshop,” he reveals. “A couple of years later
| decided to go to a creative school to study
commercial design. That is, until they kicked
me out after six months. The reason? | wasn't
allowed to work with any Adobe program! | had
to draw my designs by hand and well, I'm a
terrible drawer. My teachers told me | was by
far the worst illustrator of my year - my
portraits got rated 3/20."

On a mission to prove his teachers wrong,
Vanhaeren began sharing his work on
Behance, and after being selected as one of the
young artists for 25 Under 25 had his work
presented to all of Adobe’s followers on

Facebook and Instagram to ultimately receive
over 6,000 likes and 100 comments on
Facebook alone. Now, he has launched a new
project, #AniWall - a collection of animated
portrait illustrations depicting Vanhaeren's
favourite famous artists.

ART HIVE ONLINE GOES LIVE

| THE NEW ONLINE ART GALLERY RETAILER OPENS ITS ONLINE DOORS

Art Hive Online — a brand new curated online art
gallery marketplace - has officially just launched at
www.arthiveonline.com.

Promising to provide artists with an interactive
platform that stimulates, educates, facilitates
social and business interactions through the way
the new website has been designed, the Art Hive
Online team has described the intent to increase
artist exposure through targeted marketing as
ease of access and reach is provided to both art
enthusiasts and most importantly, the onliine art
buying audience.

“The art market is currently in a democratisation
phase both creatively and commercially. Both
artists and art enthusiasts are empowered by the
reach and access of a platform like Art Hive
Online,” said Oyin Charles, Founder and CEDO. “As
much as we believe that the traditional galleries
still have a role, we strongly feel that online art
hubs like ours are here to stay. Art buyers get to
discover art and gain access to a wide variety of
original artworks on their own terms, at their
convenience, using any online platform of their

choice without the unnecessary pressures of the
traditional marketplace. Likewise, the artists
now have access to a wider online buying
audience across a larger demographic much
faster than before.”

As well as sharing and promoting art, Art Hive
Online will also be sharing related information
such as artist interviews and photo slideshows to
give viewers a more intimate experience of an
artists’ work as well as educating collectors and
enthusiasts with tips for collecting, discussions of
art events, or by featuring new artists as the
online art gallery continues to grow.

ADOBE
INCREASES 3D
CAPABILITIES IN
PHOTOSHOP CC

A FORTHCOMING RELEASE OF CC
WILL FEATURE ENHANCED TOOLS
AND FUNCTIONS FOR 3D ARTISTS

Adobe has announced a raft of new features to

further enhance Photoshop CC's 3D capabilities

The new content adds support for additional 3D
printers and hile types, and gives artists greater
control over polygons, textures and colour. The
release date for the latest update to Photoshop
CC was still to be confirmed at the time of going
to press, but with the new content announced at
the 3D Printshows in New York and London, we
expect these features to be amving in the
Creative Cloud very soon.

MESH SIMPLIFICATION

The Simplity Mesh command will
allow you to reduce the number of
polygons in a 3D model, making
the resolution and file size smaller.
This is perfect for speeding up
your workflow when you don't
need to work at ultra high
resolution, and also for sharing
your 3D models on the web.

BUMP MAPS FROM
PHOTOS

Use any of your photos as a bump
map to create texture on your 3D
models. You will be able to convert
photos into 3D textures and control
the height and depth of the emboss
or imprint for full creative control.

CONVERT VERTEX
COLOURS

The new Vertex Color to Texture
Conversion will allow you to capture
and edit colours from a 3D scanned
object as a Photoshop texture.

SUPPORT FOR 3D HUBS

You can now print your 3D models
via local printer network 3D Hubs,
meaning that you can print your
models with the 3D Hubs service
practically anywhere in the world.

NEW FILETYPES

Photoshop will now support,
save and print SVX and 3D PDF
files, making saving and printing
models more efficient.

SUPPORT FOR
TINKERINE DITTOPRO

Photoshop will support the Tinkerine
DittoPro 3D printer in adaitionto a
range of other brands and models,
giving you more choice if you're
looking at buying a 3D printer.
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'NATALIE SHAU IS A DIGITAL ARTIST BASED IN VILNIUS, LITHUANIA

wwwbehancenet | \NLOSE VISION BRINGS FORTH TWISTED FAIRYTALES THAT FILL

natalieshau

eNatalieshau | | HE VIEWER WITH TEMPTATION AND HORROR

hen viewing the digital creations of
artist Natalie Shau, you instantly step
into @ mystical realm. Imagine riding
an ornate horse from a carousel
through a land where you encounter wondrous
fairytale-like characters, as well as creatures that
dwell in your darkest nightmares. Infusing
photography, illustration and 3D design into her work
she transports you into a world where anything Is
possible, the darkness can become beautiful and
pretty things can quickly turn wicked.

HOW DID YOU DEVELOP YOUR SKILLS?

| developed my digital art skills on my own.lam a
self- taught digital artist and photographer. | do not
think nowadays that you have to learn about
photomanipulation in school or take special courses.
There is so much leaming material available online
for free. Numerous artists have created special
tutorials dedicated to that subject. Also the best way
to leam is by practicing. You can find out what suits
you best, what techniques you can use by actually
creating and editing your own photos. But | did have
art classes in school. | also attended private drawing
classes. For a year, | studied graphic design in Central

Adobe Logo: Before doing to shoot for to art
pmlpc: nT: quite mﬁﬂmhﬁwﬁat kind ummlewu
will need. This will enable you to combine your images easily
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Saint Martins College in London. However, | noticed
that graphic design was not what | really wanted to
do. | am more into photography and photo art.

OVER TIME ARTISTS GO THROUGH AN
EVOLUTION. HOW HAS YOUR WORK EVOLVED
SINCE YOU BEGAN?

Evolution is natural for every creative person. |
learned so much during the first ten years of my
career. The technical aspects of my work improved
of course, but this is not the main value. For me, the
importance is that the technical skills allow me to
feel more free and capable of expressing my visions
better. Also my taste and interest changed. Now | am
very interested in mixing different styles to create
something unique. For instance combining fashion
and styles from different eras. | use modern symbols
in combination with historical events.

HOW HAS DIGITAL TECHNOLOGY
TRANSFORMED THE WAY YOU CREATE

NEW ARTWORK?

For me as a digital photographer a very important
role in the creative process are the improvements of
digital cameras. The possibility to have very high

resolution and crisp images is simply amazing. This
helps a lot! Being able to see the results in the
camera, then the possibility to download and use the
photos immediately after the photo session makes
the whole process so much faster and more
convenient. The same goes for scanners, graphic
tablets, etc. | am grateful that | live in a time where
we have access to all this equipment.

AS A WORKING ARTIST IN LITHUANIA WERE
THERE ANY OBSTACLES THAT YOU FACED
AND IF SO HOW DID YOU OVERCOME THEM?
When | started leaming and creating digital photo art,
very few people believed it could be a career. So | had
a pressure to choose another speciality or
something more normal. Being a banker or a doctor,
etc. And still today, | can say that not all people here

| really love the tragic
“ characters of Dostoevshy,

they are so full of pain, but at
the same time they strive for
justice and beauty 77

Dream of Winter: This piece was done for a show
at the Dorothy Circus gallery in Rome that also
featured Ray Caesar. The girl is seen daydreaming
about a winter wonderland filled with white deer

Allimages € Natalie Shau
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value creative careers, some think that it is just a
hobby and it is easy to do. | am very lucky; | work
mostly with foreign clients and galleries. | do not

need to prove to anyone my work has value and

that creative people have to be paid the same as

any other professionals.

YOU ARE A MASTER AT WHAT YOU CREATE.
HOW DO YOU FIND YOUR INSPIRATION AND
WHERE DO YOUR IDEAS COME FROM?

| find my inspiration everywhere in the world
around me. Nature is a great source of inspiration.
All colours and patterns... Plants, water, fog, and
rain. | am also inspired by historical fashion and
architecture. But | also find a lot of interesting ideas
in the modern symbols of our time,

HOW DOES LITERATURE PLAY A PART IN
YOUR CHARACTER DESIGNS?

| really love the tragic characters of Dostoevsky,
they are so full of pain, but at the same time they
strive for justice and beauty. Dostoevsky was the
person [that] said that beauty would save the world.
And | love the mysterious and even scary
atmosphere of some of Gogol's stories. He of
course took a lot from Russian folklore: witches,
mermaids, etc. | think folklore in general is a great
source of inspiration for artists.

FASHION PLAYS A BIG ROLE IN YOUR
CREATIONS. ARE YOU INFLUENCED BY
FASHION DESIGNERS?

Fashion designers are a huge part of my
inspiration. My two most loved designers are
Alexander McQueen and Eiko Ishioka who created
costumes for movies... Historical fashion plays a
big part as well.

WHAT DO YOU FEEL SEPARATES YOUR
ARTWORK FROM THE OTHERS?

It will sound surprising, but my personality. Even
through my work, | believe that the most important
part is to evolve as a human being, and when |
develop my personality it will reflect in my work
too. It's a win-win situation. My work is not about
my visual talent, it is more about adding tons of
tiny details. Most importantly it's about good
communication with your client and people around
you, having a helpful attitude, solving problems,
staying organised and not overloading yourself. |
try to do all of these things.

HOW LONG DID IT TAKE FOR YOU TO
COMPLETE THE ADOBE REMIX PROJECT AND
CAN YOU SHARE THE PROCESS?

Well | do not remember exactly the time frame
now since it was almost two years ago. | used
myself as a model and made [a] special photo
session for that in the photo studio. And then |
worked with those images to create scenery. | had

EYE ON DESIGN PORTFOLIO INTERVIEW W

Inside A Dream: Period
ieces are thematic in
talie's work. Combining
elements from the Victorian
era help to create a world that is
very dream like. A study of specific time
periods can enrich your artistic style

Some people may be so shy that even being beautiful will not
“ help them look great in photos. Thus | try to find those who

really enjoy being in front of the camera 3

to incorporate the Adobe logo into my usual style of
work. | decided to create a beautiful garden, where
the logo is a topiary covered with flowers, which
supports two girls leaning on it. With that | wanted
to show that Adobe is really supporting creatives all
over the world.

HOW DO YOU CAST THE MODELS THAT
APPEAR IN YOUR PROJECTS?

Here in Lithuania we have so many beautiful girls
who work part-time as models. We also have
several tall people. So it is not really difficult to find
great models. But the main part is not even the
looks, but the ability to open up to the camera. Some
people may be so shy that even being beautiful will

not help them look great in photos. Thus | try to find
those who really enjoy being in front of the camera.

YOU HAVE APPEARED IN SOME OF YOUR
WORK, WHEN DID YOU FIRST DECIDE TO DO
THIS AND WAS THERE A SPECIAL REASON?
Actually, | was my main model for all my first
projects, and | continue to do self-portraits today. For
me it is very easy, as | know exactly what | want to
express in my work.

WHAT SPECIAL TECHNIQUES DID YOU USETO
CREATE THE PIECE IN DISGUISE?

It was done for a ballet about Red Riding Hood.
Where she was actually a scary werewolf, That's why
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she is holding the wolf mask. This is classic
photomanipulation, where | combined all the
scenery and plants from different photos. The
photo of the model was taken in the studio. |
rented a special costume for this occasion.

WHAT ARE SOME OF YOUR FAVOURITE
PHOTOSHOP TOOLS AND HOW DO YOU
UTILISE THEM IN YOUR WORK?

| would say [the] Camera Blur filter, [as] it helps
create more natural depth of field blur.

WHAT IS YOUR FAVOURITE PIECE THAT YOU
HAVE CREATED? DID IT INVOLVE ANYTHING
PARTICULARLY SPECIAL?

| really enjoy how Eclipse turned out. This image
was inspired by one of my favourite artists, Eiko
Ishioka. She was a costume designer who
worked for movies like The Cell, The Fall, and
Bram Stoker s Dracula by Francis Ford Coppola. |
hope this work was able to portray even [a]
small particle of the mood of her great
costumes. This work was created in 2012, when
Ishioka passed away.

YOUR CLIENT LIST IS GROWING: SONY
MUSIC, CENTURY MEDIA, NUCLEAR BLAST,
OGILVY & MATHER, AND TRISOL. HOW DO
YOU FIND YOUR CLIENTS?

| do not search for clients, all the people and
companies that | have worked with actually
wrote to me with propositions for various
projects. | enjoy working on any project where |

£

Love and Doves: Nat e is fascinated

by porcelain ball joint2d dolis. Many'af
the characters that Natal = brings to'life
resemble these classic toy s This exudes
a type of innocence in her WOER

symbols of our time 33

can incorporate my style and vision, rather than
just plain technical skills. | really love when the
client trusts my taste and gives me freedom to
visualise the idea that they need.

DO YOU HAVE ANY DREAM CLIENTS THAT
YOU WOULD LOVE TO WORK FOR AND WHY?
I would love to work with people like Bjork or FKA
Twigs. Their music and style is just so appealing to
me. | would also love to work for a fashion
company, where | could create illustration to print
on fabric so that people could wear my artwork.

IF YOU COULD EXPERIMENT IN ANOTHER
MEDIUM, WHICH MEDIUM WOULD IT BE?

I think | would love to experiment with 3D
character design and try to print it in [a] 3D printer
to create [a] real figurine from my artwork.

WHAT ADVICE WOULD YOU GIVE TO ANYONE
WHO IS LOOKING TO LAUNCH A CAREER IN
DIGITAL ART AND ILLUSTRATION?

My advice is to be self-critical and always strive
for perfection, work a lot and listen to people who
could give you great advice in this field. But also
do not pay attention to the people who want to
put you down and make you feel that your effort
Is unworthy.

storm: It is very effective to use splashes of
or ::_j_h[ colour in an almost manochromatic
technigue will focus the viewer

and draw their attention. | he usage of p

directs your attention to the girl's face

o]

‘ ‘ | am also inspired by historical fashion and architecture.
But | also find a lot of interesting ideas in the modern

PORTFOLIO TIPS

NATALIE SHAU'S SECRETS TO CREATING
STUNNING ARTWORK

B LIGHTING

For your composition use images that are lit from the
same direcion. It your main hgure is lit from the front,
back or side; make sure that other obyects are lit the
same. You can always turn and fthp [the] image, or
overpaint the Light and create shadows

B SHARPEN

If you want sharp and detailed artwork, always use

photos with a sharp focus. If the image 1s not sharp
you can sharpen it using a High Pass hiter. For this

you need Lo duplicate your image layer, change to
Overlay moade over your original layer and go to
Filters>0Other> High Fass.

B BLUR FILTER

When you paint something over a photo - for example
Improving skin tone, painting shagows, elc. and it doesn |
look '-.r1'||:'n-i.:-l h enough - you ¢ --':I‘ always use a Blur hiter to
blend shadows and light to make it better

B PAINTING HAIR

If you do not have brushes to paint hair, you can create
your own by painting few black dots on a white
background close to each other, Select this area and then
Define Brush Preset, this will create your own unique
brush, You can agjust brush settings in the Brush panel

B DOLL EYES

Want to create a doll-like look for your model by
making her eyes larger? | do not suggest using the
Liquity hilter! It will make her look unrealistic and funny
(unless this s your goal). You can enlarge an eye by
selecting the area, then creating a separate layer. Then
enlarge it with Free Transform
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HONOURING PRATCHETT

| AWARD-WINNING ILLUSTRATOR BARTOSZ KOSOWSKI TO

FIND OUT ABOUT HIS ILLUSTRATION OF TERRY PRATCHETT'S DISCWORLD

ABOUT THE ARTIST

BARTOSZ KOSOWSKI
www.bartoszkosowskicom

2

Bartosz Kosowski is an illustrator
basedin Lodz, Poland.

Kosowski runs Blackbird
llustration studio, working on
various projects from portraits to
editorial illustrations. His Lolita
poster for a San Francisco Stanley
Kubrick exhibition recently
received two gold medals from
the Society of lllustrators New
York and Los Angeles.

NAME OF PROJECT
DISCWORLD

J, "[I,hh‘ ’l' r,;r l Self-portrait

1.‘&‘5._ “;.lw'r' \M" b

t's now been four years since award-winning

llustrator Bartosz Kosowski first quit his

regular job to focus solely on his art, and he's

been gaining more and more recognition ever
since, creating work for everything from the New
Yorker to Newsweek. His illustrations have
garnered him awards from American lllustration,
European Design Awards and Associazione
Culturale Good Design.

Kosowski's latest editorial illustration project,
however, was more personal than most. Hed been
commissioned to create his very own interpretation
of Temry Pratchett’s infamous Discworld for a
double page opening illustration in Wysokie Obcasy
Extra magazine.

“As ateenager | was a huge fan of Discworld
and | read lots of Pratchett’s books so you can
imagine how excited | was about this particular
commission,” Kosowski begins. “Redrawing
Discworld is a bit like re-interpreting John Lowe
and Alan Lee’s Middle-earth - there is always the
risk that the fans will see that you did something
wrong. So though the art director gave me total
freedormn and told me to do it my way, | didn't want
to go too far away from the original concept.”

Instead of creating the Discworld universe
from scratch, Kosowski decided to re-interpret
Josh Kirby’s iconic Discworld illustration,
bringing the familiar shapes and figures into his
unique style. As with all his illustration work,
Photoshop was crucial from the beginning.

HOW WERE YOU FIRST APPROACHED TO
CREATE THIS BEAUTIFUL DISCWORLD
PIECE FOR WYSOKIE OBCASY EXTRA
MAGAZINE?

| have been working with Wysokie Obcasy Extra
magazine for a few years now and | have done
plenty of illustrations for them.

All these illustrations, however, had been
editorial pieces for psychological articles on
such issues as assertiveness, breaking up or
positive thinking. So when the art director
contacted me again with the idea of drawing a
Discworld piece, it did come as a bit of surprise.

HOW DID YOU DEVELOP THE INITIAL IDEA,
COMPOSITION, AND COLOUR PALETTE FOR
THE PROJECT?

The task was to create a double page opening
illustration that would be my own interpretation of
[Pratchett’s] Discworld.

The choice of composition was somehow
limited by the page layout that | was provided
with [just like most editorial-led illustration]. |
knew that | had to leave some space on the
left-hand side for the article title and the lead and
therefore | had to focus on the right-hand side
and place the focal point there.

Apart from that, | was free to do it ‘my way’,
using the colours | like. | decided to go for the
retro palette of muted browns and greens with a
pinch of blue as | felt it would simply look good
and would correspond with depictions of the
Discworld universe that every Pratchett fan is
familiar with.

WHICH WACOM CINTIQ DID YOU USE? WHAT
DID YOU LIKE ABOUT USING IT?
| used the new Wacom Cintig 27 HD touch and |
must say that | like it quite a lot. Before | got it, |
had used Intuos 5 L for a few years and though
it worked really well for me, the Cintig's biggest
advantage is that you can work more freely. It
Is much closer to the analogue drawing
experience and therefore more natural to use.
Plus, the amount of pixels that you get here and
the QHD display quality is absolutely fantastic.

Of course, being an early adopter, you have
to deal with some glitches that hopefully will be
ironed out eventually but overall, the new Cintig
experience Is amazing.

| also use the Wacom Ergo stand and it does
help a lot when you draw several hours a day. It
lets you adjust the tablet to the position that is
most convenient for you so that you don't have to
lean over the screen all the time, which is
definitely good for your back.

COULD YOU TAKE US THROUGH THE
WORKFLOW THAT WENT BEHIND CREATING
YOUR DISCWORLD ILLUSTRATION?

First, | did the research on the topic and went
through all the possible Discworld interpretations
that | could Google, studied the anatomy of the
great sea turtles and elephants and then simply
started sketching.

Once the sketch was ready and given the
green light by the art director, | inked the piece
digitally. This took me a while as the illustration
Is quite detailed and | always try to keep the
linework very precise. Next, | began colouring
the elements starting with the basic shapes such
as the turtle’s body or scales and then going



|’
L _—
When creating an illustration for a magazine
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Final version

deeper into shades and light.

Finally, when the whole picture was coloured,
the illustration got into what | call [the] post-
production stage when | subtly changed the
colours, worked with the opacity of some layers,
added gradients and applied some filters to the
whole image.

WHAT WERE THE MAIN PHOTOSHOP TOOLS
AND TECHNIQUES YOU USED?
| think the most important thing in any illustration is a

decent drawing and a good array of brushes that
you work with. | always start with a blue pencil
sketch and
ink my illustrations with the custom inking
brushes. In this particular piece | used Kyle
Webster's Dry Media brushes for inking as they let
you to keep the traditional organic feel thanks to
the brushes’ shape dynamics and a bit of noise.
For the background | used my own hi-res
paper texture onto which | applied different kinds
of scanned splashes created manually with

watercolour and ink. | also applied the linear
gradient (Normal or Color Burn) to some layers to
make the illustration more vivid.

| use a lot of masking, opacity and subtle
gradients or delicate colour burns to create
watercolour-like effects. | really like the traditional
look of the illustration and | believe that the key to
this look is using the effects that Photoshop offers
in a subtle way. If you overdo it, you lose the feel of
a handmade drawing or painting and the
illustration becomes digitally soulless.
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KRIPPA DESIGN

MEET THE YOUNG DUO WORKING OUT OF A SMALL
OFFICE, CREATING STRIKING ARTWORK FOR BIG
NAMES IN THE DANCE MUSIC SCENE

eet the design duo with youth on their
side, proving that size isnt everything
when it comes to building up a
successful studio. Arvid Rehn and
Christoffer Tunsater, both 17-year-old Swedish
high-school students, make up Krippa Design,
working out of a home office and designing posters,
flyers, cover art and more for some of the top names
In the electronic dance music (EDM) scene.

Is being in your teens an advantage when working
in this industry? “Sometimes yes, sometimes no,”
says Arvid. "“Some bigger companies take advantage
of our age, simply because we don't have such high
rates compared to more developed design studios. [It

is also] difficult to both keep work deadlines and
have tests in school. Some clients appreciate our age
and want to work with younger, new-thinking
companies. Many of them compliment our age and
are very impressed, [which is] always great to hear!”

Arvid and Christoffer set up the studio in May 2013
and began by working out of a small bedroom
studio. Now, though, they have a newly renovated,
clean office space, and although it is still based at
Christoffer’s place, as before, it is much more suited
to the work that they are doing. They are happy with
their space for now, saying that it perfectly fits their
needs: “The renovating took a few months and we
are now very happy with it. The place we work inisn't
our top priority though; we believe that the work
could be done anytime and anywhere, as long as you
have a computer. You don't produce any better
visuals just by sitting in a multi-million dollar studio.
In the end, it's the quality of the work that matters.”

The office space itself is clean and fresh, with a
monochrome theme and simple lines. There is very
little clutter to be seen, which is deliberate, explains
Arvid: “Sometimes you can sit down for hours [and]
just [be] imitated by a desk full of crap. At Krippa, we
keep our desks clean and we use the time to work on
projects instead. The studio consists of light-coloured
elements, which makes everything fresh.”

The small space houses everything that they '
need to run their business. Christoffer uses a “ YOU dont prOdU_CET anY bE’ttE’r _
custom-made PC most of the time, sometimes with VISLJalS JUSt by Slttlﬂg N a mUltl'
a Wacom Intuos tablet. Away from the office he mlulon douar StUdiO |ﬂ thE' end it*S thE'

uses a MacBook Air for fast edits on the move. “But |

don't start any new big projects on it,” he says. “My quality of the work that matters 7

Mac is only for the purpose of making fast small

changes and edits of previously made designs. | '
must sit at home to start on any new project, where B
| feel the most comfortable.”
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ABOUT THE STUDIO

KRIPPA DESIGN
WwWw.Krppadesign.com
@krippadesign

Krippa Studio is a clean, new and fresh digital design

studio located in Kalmar, Sweden, working out of a small

but perfectly equipped studio that is perfect for the grvi_d Rehn Christ lAr nTunsﬂter
services that it currently provides. usiness Manager Visual/Art Director

4 Team Krippa: The studio
may be s but it meets
thunetdsnfthudunthnt

make up Krippa Design

| Krippa Designs

All images(t
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Cover art: Cover art design for You'll
Be Sorry by SpaceMonkey and Chuchky
Reyes, featuring Tyler Fiore

Prestige Management:
Logotype made for Prestige
Management

PRESTIGE

GROUP

MANAGEMENI

Other than this, he uses a Nikon D3100 for
photography as required, Adobe lllustrator and
Photoshop, and Maxon Cinema 4D. Of course
Photoshop has an important role to play in the
creation of Krippa Design's work. “l use Photoshop in
almost everything | do,” says Christoffer. “It's a
fantastic program. Even if | make a logotype in
lllustrator, | often take this and make a design in
Photoshop with it. It's a very complex program, but
when you ve leamed the basics, everything else just
falls in place. I'd say | use Photoshop about 65 per
cent of the time.”
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INDIVIDUALS

YOUR WEEKLY DOSE OF EDM

-HIGH -

FREQUENCY

AT N DULGE, ATLANTIS THE PALM, DOORS OPEN FROM 9PM-JAM
ADVANCE TICKETS 100 AED / DOOR 150 AED

FOR RESERVATION & INFORMATION 056-175 1010 /7 055-200 4322

Sick Individuals: A flyer

for Sick Individuals

M;_ N

These tools are used to create promotional
materials for DJs and music acts around the world.
Recently, Krippa was asked to create the graphic
profile for the Weekend Festival 2015, Finland's
biggest EDM festival. “It has been great working with
the team and they're very easy to work with,” says
Christoffer. “We started [working with them] back in
2014 and made two T-shirt designs, but then in early
2015 we got the opportunity to make everything for
them: logotype, flyers, website, merchandise, etc.”

Much of the work that the studio designs has a
distinct modern style: bright colours and cool

B A TS

- N

graphics. This is something that Christoffer tries to
inject into client briefs, though it depends on how

narrow that brief is: “| always try to make my own
imprint on designs I'm making for clients, even if the
restrictions are very tight. Though, [similarly] if the
client doesn't give me any information at all, it can
kill the creativity as much as If the client gives me a
completely restrictive [brief]. If you are in a
non-creative state of mind at that time and your
client gives you no more than ‘do something cool,
bro’, you sit there and don't know what to do to
satisfy the client.”
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B GRAPHIC PROFILE FOR WEEKEND FESTIVAL 2015

CHRISTOFFER WALKS US THROUGH THIS REDESIGN FOR THE 2015 WEEKEND FESTIVAL, FINLAND'S BIGGEST ELECTRONIC DANCE MUSIC FESTIVAL
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0 1 | MAKING OF THE LOGOTYPE DESIGN 02 | DESIGN THE FLYERS

The first step was to create the logotype We were now done with the logotype, 03 WEBSITE DESIGN
design. We got the basic logotype, but had to so we already had the ground design, which all | didn't really code it as they already had
create the visuals around it. The theme for 2015 of these next steps have been based out of. a PSD layout for the website itself, | just had to
1s Super Digital Edition, so we had to have that in They asked us to make the A3 and A5 flyers to create the design that was going to be displayed
mind while creating it. be printed and hung up all around Finland. in the background, as shown in this step.
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04 ARTIST AND SOCIAL MEDIA BANNERS

WEAPQN
About 50 artist banners and 10-20 different social media banners 0 5 APPAREL AND MOBILE CASE DESIGNS
and miscellaneous designs [were] needed, and we also had a tight deadline We made two T-shirt designs for the festival in 2014, which we also
for all of these. This included things for Facebook, YouTube, Twitter and other attended ourselves. But now we had to make it all; a bunch of different
printable mini-flyers. This part took the most time to make. merchandise designs and mobile cases [were] needed.




In order to flex his creative muscles, Christoffer
publishes a weekly design, which is published on the
Krippa website and is available free to download as a
wallpaper for desktop and mobile devices. “It all
began with some leftover designs made for
customers that they didn't like,” he says. “l came up
with the idea of sharing one non-commercial design
each week. It's not leftover designs any more. Now |
sit down, mostly on Sundays, which is the day they
are released, and just flush my mind of all the
inspiration | ve gained over the past week. | have to
say that | love to do these. | feel no pressure about
[getting] anyone to like it or not. If | like it, it's done.
They are often abstract, crazy and sometimes just
very random.”

In order to work effectively, the duo have very
distinct roles at the studio. Arvid takes care of the
business side of things, such as customer service,
payments and making sure that the whole process
runs as smoothly as possible. Christoffer is in control
of the design side of things. He creates all of the
artwork at Krippa, although they both brainstorm
ideas for projects to come up with the best ideas. As
such, they are both dependent on each other,
because one could not work without the other. “We
both have individual strengths that work well
together,” agrees Arvid. "My biggest strength is being

very connected to the clients and coming up with
It's a very complex

“ program, but when you've

learned the basics, everything

else just falls in place. I'd say |

use Photoshop about 65 per
cent of the time 99
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new ideas to improve the company, while Christoffer
is working. In my opinion Christoffer’s biggest
strengths are to deliver quality work and think
outside the box.” There are quite a lot of things that
set this studio apart from many others, not least
their small setup and young age, but Arvid thinks
that it is this division of labour that makes them
unigue and what keeps them working so
seamlessly: “| personally think we have a pretty
unique way of cooperating together. Normal studios
split up the work so that one person is taking care of
the logos, one is designing cover art, etc. At Krippa
we decided to split the work [so that] | am taking
care of business-related stuff and Christoffer is
taking care of everything that has to do with
designing. This works surprisingly well and we will
continue work this way as long as possible.”

B A DAY IN THE LIFE OF KRIPPA DESIGN

ARVID AND CHRISTOFFER WALK US THROUGH A TYPICAL DAY

09‘00 ‘ MORNING ROUTINE

. At Yam we amive at the Krnppa
studio and start up a new fresh day with new
challenging projects in our hands. Here we start by

discussing today's schedule and get ready for the day

1 -I _00 ‘ KEEP UP THE WORK
. Here we have started today's

projects and are fully focused on the work. Working
hard pays off.

. Christoffer working:
Christoffer starting on a new
project for the 0) duo Nervo

While the studio is enjoying a great deal of
success at the moment and the dynamic is
working well, Arvid and Christoffer are well aware
of the other priorities in their life. In particular they
are not going “all in" with the studio until they have
finished school. But they do have big plans for
expansion in the future: “After school [has finished]
we will try to have this company going so well that
we can work full time. Our dream is to open up a
big office and even employ some workers too. We
have got two more years at high school, so a lot
can happen, but it is our plan for sure. We [didn't]
think this hobby project that we started two years
ago would turn out this well — we are just two
normal guys who have a big passion for music and
art. It feels like we don't have any limits so far that
can stop us. We will just continue doing our thing
and we're both very excited to see what the future
has to offer.” As are we.

COFFEE BREAK
Here's the moment we've been

13:00

L
waiting for all morning: the coffee break! Now we sit
down for a couple of minutes to speak about

everyday stuff and just take it easy
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Arvid at work: Arvid contacting
\ clients in the small studio space
‘. that Krippa Design work from
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TOP 5 PRODUCTION TIPS

B FILE MANAGEMENT

Keep aclean desktop, hard drnive or whatever you are saving your

files on. It is really important that you name and folder your files in an
v-to-findway!

B KNOW YOUR SHORTCUTS
While working with Adobe software, or any other program, know
the keyboard shortcuts for all tools you often use. lIt's so much easier

and faster than to manually click on all of the tools

B COLOUR AND LAYOUT

Have nmind thal a designer s eye s very different froma clenls
Even though you like that crazy layout and those strong colours, the
Chent probably doesn L You need to try thinking [like the client]

B EFFECTS AND BLENDING OPTIONS

Iake some time to add more colour effects and play with the
blending options for each layer to make the hinal design

.r' !‘ !lr.'.]."\-ll |.'.'I|l_|.._|”l'lll-_: e F ..'I.-'.r-l"“_:lrl:tl.':lljl' .|']' i ..|‘|:
something new and beautiful

B BECRAZY
Sticking to the same techmiques and effects doesnt Mpress your
istormers. Try to. once in a while, think of something new. A new

plug-in. a new effect to use etc_A fresh mind 1is what the client wanils

All images: © Krippa Designs

/

. _—
% DISCUSS THF DAY _
1 4:00 BOTH WORKING ON PROJECTS 1 6:00 | ARVID WORKING HARD 1 8-00 ‘ Now the day is over, we sit down

After the break we are back at Arvid is now fully connected to the to discuss the day, its positive and negative things
the work, keeping the focus up all day to get the clients, discussing, contacting and receiving feedback  and what to improve. We also write the schedule
best results possible, from the customers. for the coming day.
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Send your completed form to:

Advanced Photoshop Subscriptions, 800 Guillat Avenue,
Kent Science Park, Sittingbourne, Kent ME9 8GU

EVERY
ISSUE
PACKED
WITH...

© Professional tips for getting the
most from Photoshop

® Advanced techniques

© Interviews and advice from
industry experts

@ High-quality tutorials to help you
create incredible images
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& Save 30% off the cover price
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© Never miss an issue

ORDER BY

31 JULY 2015

Use code (115 for this offer.

YOUR DETAILS

Title First name
Surname
Address

Postcode Country
Telephone number

Mobile number
Email address

DIRECT DEBIT PAYMENT
__ UK Direct Debit Payment

| will pay just £12.50 every 3 issues (Save 30%)

: Instruction to your Bank or
Building Society to pay by Direct Debit

i Puk 7 Limitesd], BOO Cuillad Averue, Ment

DIRECT
Debit

J.|.|lﬁl-!.. 1 & hll m the form

Hama arnd bl parstal sddiire i ol pour Bark o Bl ragy SocmTy Chrbiph e ok rot oF il s = R v

Te: Tha Bl g o [ i, B el gy S iy

|5|-:;|1 8 E:il

Ao ore ki

Reference Nombe

Py g . il Friima o 1o e e Ben b or Buibding Sodiety
Floaie iy biagine Pubbbisg Lisited Dided | Debia Iraw Dhe i-0dinenl bl iled in ki

e Lioe sl o Bee saleguants v red by the Dieec] Dok guasanies | unseryiend
Flmrrw s of scoowd Bokdanini That Thin inabructson maey remmain with imagine Publichieg Lissied snd of o, detaily will be
passed om el eciron sty ta my Bank Buibding Sty
I Si gnature (i)

Bramcth sort oo-de

B b B il ey Sy @O0 T P DT

| ot

Banis ardd Busdlding 50wt ies mary fast sidepl Deed ) Delii iAitfuctiom lor e Bypei ol sdoaunt

PAYMENT DETAILS
YOUR EXCLUSIVE READER PRICE, 1 YEAR (13 ISSUES)

UK £62.30 (Save 20%) _ |Europe-£70 | World - £80
| USA-£80

Cheque

L | enclose a cheque for £

(made payable to Imagine Publishing Ltd)

Credit/Debit Card

l Visa Mastercard | Amex | Maestro
Card number Expiry date

Issue number \__ (if Maestro)

Signed

Date

Please tick if you do not wish to receive any promotional material from Imagine Publishing Ltd by post ]
by telephone |_ via email

Please tick if you do not wish to receive any promotional material from other companies by post/| |
by telephone | | Please tick if you DO wish to receive such information via email ||

TERMS & CONDITIONS

Terms and Conditions: This offer entitles new UK direct debit subscribers to pay only £12.50 every 3 issues.
New subscriptions will start from the next available issue. Offer code PQ15 must be quoted to receive
this special subscription price. Details of the Direct Debit Guarantee are available on request. This offer
expires 31 July 2015. Imagine Publishing reserves the right to limit this type of offer to one per household.
Subscribers can cancel this subscription at any time.



026

3D & PHOTOSHOP:

THE COMPLETE GUIDE

PHOTOSHOP NOW PACKS IN MORE 3D TOOLS THAN EVER BEFORE, AND

PROFESSIONAL 3D ART

ISTS ARE USING THE PROGRAM WITH INCREASING

FREQUENCY. WE GET THEM TO SHARE THEIR TOP TIPS AND EXPERT ADVICE

bviously, there are some artists for
whom 3D and a dedicated 3D package
Is @ must. Most likely, you can't work
In movies or games without those
skills. But there is an increasing band of artists
for whom 3D is one arrow in their bow, one way
they can provide the imagery their client -

heart - desires. And for these merry travellers,
the fact that Photoshop can now open 3D files
and has its own 3D workspace to edit these files
In Is @ dream come true.

“Everything | do in 3D is to get the best
possible base for the image by providing
photorealistic materials and lighting, but
Photoshop is where the magic happens,
accentuating colours, contrast, point of attention
for the viewer's eye and expressing an overall
mood in the image,” says Frédéric Muller
(www.fredericmueller.ch), who works in Maya,
Mudbox, HDR Lightstudio and Photoshop.

Cristian Koch (www.cristiankoch.de) is
another artist who uses 3D almost all the time,
due to the creative freedom it gives him. There's
the “option of playing with the camera, this
gives me new framing or light options which in
traditional 2D would mean, take the photo again

or make another drawing, which | cannot find
convenient in terms of production.” In addition,
he finds the “blend of art and engineering” that
3D offers exciting. "What made me go down the
road of 3D was my lack of drawing skills,” he
admits, “and that | realised, that | have a good
spatial ability... But what pushed me more was
my passion for creating images and being able
to sometimes ‘bend the reality’, and 3D opened
that door.”

So what 3D reality-bending can Photoshop
accomplish? The first thing people tend to
mention is its ability to extrude 3D type, but
having a 3D workspace within the image editor
does allow for more than that. You can create
your own basic 3D shapes, you can edit ones you
created elsewhere or models you've bought, and
you can prep for 3D printing. This is why Koch
says Photoshop’s 3D workspace is “extremely
useful, as it allows me to quickly draft without

£) Andrei Lacatusu
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much technical hassle, reducing everything to
just purely creative process, | can play with
basic 3D models or import models created in
other 3D software, | can paint textures and
create my basic layout without wasting time
on technical hassles.” He uses 3ds Max,
ZBrush, After Effects and Fusion, as well as
Photoshop, and says “What | find really
interesting about this is that Photoshop
relates very well with all of them, making

my job easier, allowing me also, to

effectively separate the creative process from
the technical.”

Michael Fawke, founder of architecture and
interior design visualisation studio Plusform
(www.plusform.co), adds that “Establishing a
correct perspective and being able to add
objects with reasonable shadow and light
quality is a great feature for those that do not
have a dedicated 3D application. For designers
not looking to integrate 3D into their

PHOTOSHOP'’S 3D INTERFACE

3D & PHOTOSHOP: THE COMPLETE GUIDE TECHNIQUES B

© Frédéric Miller

workflow, just having that option built into
Photoshop is a real plus.” But while
Photoshop’s 3D offering may not be enough
for artists like Fawke yet, one day it might be.
Juri Jablokov (www.dekus.carbonmade.
com), who recently finished his university
thesis about Photoshop's 3D capabilities, says
“Technology and software evolve and more

efficient ways of getting results are developed.

These days, with Photoshop, it is possible to
texture your object directly on the surface in
the 3D viewport, as opposed to traditional
texture painting in 2D UV view... In Photoshop
CC there is also a Live Painting feature that

3D print from here: Staiger is a designer
rather than a producer, but he has
experimented with 3D printing. “| loaded a 3D
elephant into Photoshop and prepared it for
the 3D print, which was done in less than five
minutes. It worked perfectly!”

A bird’s eye view: Toggle here to display
Scene, Meshes, Materials or Lights.
Remember that the 3D panels works in
exactly the same way as the Layers panel.
Toggle the eye on and off to see elements
In the mix

Type right: Staiger says “Photoshop’s 3D tools
make it fairly easy to create metallic typo
which you can use for any kind of cover or
poster. Pick a classic typo, such as Dark11 or
any roundhand font. Create a 3D Object of it.”

How you see it: "Use the front camera in
Orthographic mode. Give the front mesh a
round extrusion. Pick a shiny, highly reflective
material for the front and replace the standard
IBL by a detailed photograph with a high
dynamic,” adds Staiger. Orthographic Cameras
maintain parallel lines without convergence,
and display the model in accurate scale view
without perspective distortion.

allows you to have both the 3D and 2D view
and both will update in real time as you paint
or edit the texture.” He wonders whether
Photoshop will split in future, with one version
with enhanced 3D capabilities, and one without.
Koch notes that with the increase of these
constantly progressing and "emerging
technologies such as OTOY (with the Octane
render plug-in) that soon will allow Photoshop
to make photorealistic renderings directly
without leaving the application, this will open
new possibilities for 3D illustrators to
accomplish things that previously required to
move to another software for rendering.”
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© Uli Staiger

ENHANCE 3D IN PHOTOSHOP

So, while Photoshop isn't replacing the dedicated 3D
application — at least, not yet - it is bringing 3D more
into an achievable world. And isn't that what matters
most, when the goal of most good 3D work is to make
itself seamless, realistic, even invisible.

“The best compliment a 3D artist can receive is the
following question: ‘Is this a photo?” says Andrei
Lacatusu (www.andreilacatusu.tumblr.com). "Most
of us try to achieve realism, but that is no easy job. | did
bad 3D as well but | hope | developed enough skill and
experience to have passed that stage. From my
experience, | think that the element that adds the
biggest value in a 3D generated image is represented
by shading. Without the proper material properties and
textures, one cannot achieve the slightest amount of
realism. After that, the light counts a lot, just as in
photography, in order to enhance the image.”

Matt Kohr (www.mattkohr.com and www.
ctripaint.com) says that “achieving unity” is his goal.
Sometimes he finds he's happy with a composition at
the colour block in phase of painting 3D models he's
imported, but “adding photos is always dangerous
thing. Avoiding a noisy, gritty, mess is crucial so the
last phase is where | balance the various elements
ensuring my initial colour vision remains intact.
Generally I'll use a combination of blurring, colour
comrection, and airbrushing to balance my image.
There's no one-size-fits-all solution for this balancing
phase, as every painting offers different challenges”.

Mark Mayers (www.markmayers.co.uk) says he
generally uses Photoshop for “postwork techniques to
incorporate additional textures such as distress effects

V4
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ESSENTIAL LIGHTING RULES

MIER LEE REVEALS HIS APPROACH TO REALISTIC 3D LIGHTING

’| think the most important thing in 3D space Is
light,” says Lee, “and we should know how the
light works. Models would be looking completely
different depending on where the light sources
are, and what the colours are. In portrait painting
for example, the first thing to do is to separate the
light and dark in value, and warm and cool in
colour. This works exactly the same in 3D
software. | usually set up at least two different light
sources. The first one is the key light (or main
light), which is the first and usually the most
important light that a photographer and
cinematographer use in a lighting setup. This key

light controls the mood of your work. The other
one is fill ight. This is a secondary light source that
may be used to reduce the contrast of a scene, or
to change the colour of the shadow.

Photoshop is the most powerful tool that can
control these two light sources. When using
Photoshop, | always use adjustment layers such
as Level, Curve, Gradient Map, Hue/Saturation
and Color Balance. But my favorite one is Gradient
Map. It allows you to easily change the colours of
the light and shadow at the same time. And then |
set it up as Overlay mode, and put some
transparency onit.”

‘ ‘ The best compliment a 30
artist can receive is the

following question: ‘Is this a

photo? Most of us try to achieve

realism, but that is no easy job 39

ANDREI LACATUSU /
WWW.ANDREILACATUSU.TUMBLR.COM/

to 3D objects. | use various blending modes to make
the object look as realistic as possible. | also use a
non-destructive Dodge and Burn technigue whichis a
50% grey layer in Soft Light mode. This is painted at
20% Opacity with black and white to correct lighting.
Sweet.tif is a good example of this texturing/lighting
method. 3d apps can also create multi-pass renders
such as ambient light, Z Depth as well as compositing
Alpha Channels for added realism.”

For Kohr, making 3D look real, or “grounded’ is
“mainly a matter of correctly integrating it into the
painting. Level of detail, film grain, lighting - all of
these things will ruin the illusion if you simply add a
photo without working it into the painting. Implied
detail tends to work best in areas of the painting that

© Mier Lee
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3D FILE TYPES
COMPATIBLE WITH
PHOTOSHOP

PHOTOSHOP CC OPENS MORE FILE TYPES

THAN EVER BEFORE, THE LIST NOW
INCLUDES THESE HANDY 3D OPTIONS

1. .3DS
Software: 3DS Max
Used for: Modelling

Having been around for donkey's years, .3ds has
become the de facto file format when it comes to
transferring or storing models. At the moment,
Photoshop can import it, but not export.

2. DAE

Software: Many, including Blender,
Poser, SketchUp
Used for: Being an intermediate

A file format designed to allow people to transmit
3D data between programs, most applications can
use COLLADA's open standard XML schema.

3..08J
Software: Many, including Cinema 4D,

Blender, Maya

Used for: 3D geometry

There's also a companion file format in .mtl that
describes the material properties of the objects
with an .obj file,

4. .JPS
Software: XnView, NVIDIA 3D Vision

Photo Viewer
Used for: Stereoscopic images

The stereoscopic JPEG format can be used to

create 3D effects from two 2D photos, or created by

cameras that have two lenses.

2. .MPO

Software: MPO Explorer, Stereo Master
Used for: Stereoscopic images

The Multi Picture Object file is another format for
storing and sharing stereoscopic images. Many
programs can open them, but sometimes can only
see one of the images.

6..U3D
Software: Adobe Acrobat
Used for: Vertex-based geometry,

lighting, textures

Universal 3D is a compressed file format designed
to be compatible across a variety of applications,
and to create 3D images for PDFs.

HOW TO ACHIEVE REALISM IN 3D

CRIS KOCH EXPLAINS HOW MAPPING AND LIGHTING CAN
BRING YOUR IMAGE TOGETHER IN PHOTOSHOP

0 7

U 1 A WORKFLOW OF YOUR OWN 02 ‘ SET YOUR SCENE

Koch built this character in 3ds Max, and “Import the 3D file going to 3D>New

when he comes to import it into Photoshop, he 3D lawﬂr from flir’ﬁ thrﬁn \YOU can llr‘le up the

has a checklist: “A) Make sure the uvw mapping is

comrect. B) Make sure the model is in the position 0 h-.'ﬂ.. l‘~.n:]|l ound, once e Jur“ﬂhmg IS Ilr"lr.?d up,

in the world (this will make your life easier later.C)  double-clicking in the 3D layer will reveal all
Do a quick check in the normals of the model that properties for the 3D scene, where we can
are all facing outside.” adjust our textures, lights, cameras.

03 ‘ ADD SOME REALISM
Now it's time for realism. "Once | am happy with the match of lights, depth of field and

perspective, says Koch, '| render both layers and start retouching areas, and approaching the whole
potential of Photoshop in compositing. As | come from a 3D background, | created reflection pass,
occlusion pass, beauty pass to have more control over the whole image.”

© Cris Koch

are not the focus.” As you can see if you check out
Kohr’s tutorial, on FileSilo, about painting over his 3D
car model, you'll see how he “draws the attention away
from the shadowy undercarmriage. The viewer probably
won' scrutinise this area of the painting, so it's a great
place to use implied detail. Implied detail tends to work
better when seen from the comer of your eye. The
focal point must be given much more attention.”

Uli Staiger (www.dielichtgestalten.de) too is a fan
of Photoshop overpainting, to avoid his 3D looking “too
clean’. For a recent composition of a long waterslide,
he used “a stack of several patterns in a psd file and
apply that carefully with a fuzzy, multi-jittered brush
along the edges of the slide. Also, | use Photoshop's
layer options, so that the painted dirt gets a 3D feeling. |
enjoy Photoshop overpaintings very much anditis a lot
more intuitive then a pure CGl production.”

For Jablokov, it's the different 3D and 2D views that
makes Photoshop so good to use. “For example,” he appears as a completely straight one in the model.
says, ‘you have an organic model ke analiengunora  Photoshop's 3D tool comes to the rescue here.

© Ifthikhar abdul nasser

character and you want to have a straight line on it. “You can work on your 2D flat texture just like any
Maybe it's a tech line on the gun or war paint on the other day and when needed, pop up your 3D model
characters face. But your UV's are flattened so that and paint a bright red line where you want your
there's minimal stretch and it can be difficult to judge detail to be. Then, continue in the 2D view to render it
where you need to make that specific line so that it out precisely.”
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TEXTURING AND MAPPING

030

© Juri Jablokov

A fairly typical workflow might to start with a
sketch, go into a 3D app and then do the post work
in Photoshop. Ifthikhar Abdul Nasser (www.
ifthikhar.com) certainly does something along
these lines, noting, “l then use textures as overlays
and also to create specific environments in
Photoshop to suit the mood/idea complimenting
the main render, transforming it into the way |
intended to create in the first place. Other editing
tasks like colour comrections, lighting, shadow/
highlight, toning etc are also involved.”

Mier Lee's (www.miershine.com) main 3D tool is
Cinema 4D. He uses it to model “objects as basic
structures for my work. If there is any texture that |
need to put on, | edit it with Photoshop or Illustrator,
and then | save it onto Cinema. Therefore, | always go
back and forth during this process. Even though
Cinema 4D renders models, lights, textures and
colours for you, there are still a lot of things to be
finished up with Photoshop after you render out all
your frames. When | design style frames, | always
use Photoshop to retouch colours, to edit textures
and values, to exaggerate highlights and shadows,
and to mix with 2D images and 3D renders to make
them look more realistic.”

Staiger often starts by building a background
composition with Photoshop: “This will be used as a
scene that cammies the 3D content. It could be a
carefully composed aerial shot from several
photographs of clouds and landscapes. Then | place
the already rendered 3D object onto that scene.” He
uses Cinema 4D to create his 3D, and Photoshop is
used in various ways: ‘| take psd files as 3D textures.
The good thing is that Cinema 4D supports the full
range of Photoshop psd, even typo, pattemns and
comection layers. | can choose which layer | want to
assign to which texture channel. Later in the process,
| render in multipass mode. When | open the
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THE POWER OF LIGHTING

JURI JABLOKOV SHOWS HOW ENVIRONMENT MAPPING POWERS UP LIGHTING

£) Juri Jablokov

»

Juri Jablokov worked on the sculpt of this fantasy axe in 3D-Coat to

create the basic shape and detailing of the weapon

rendered file in Photoshop, all the lights, reflections,
speculars and shadows are on separate layers and,
very cool, all alpha channels are there already. Also, |
use Photoshop for building a general overall look.”
Textuning and mapping are where Photoshop can

YT |
- - - -

Move in 3D: Want to Rotate, Roll,
Pan or Slide your shapes? Those
controls are accessible here

appear in the Layers panel, and -
just like working in 2D mode - you
can apply them in different ways

Then he brought it into Photoshop to map (maps used include
Diffuse, Normal, Ambient Occlusion, Specular), texture and light

really shine. Muller explains the different techniques
depending on the object: “I might have to map an
existing texture onto the flat UVs (for example leather,
wood, scratched metal images, etc) in Photoshop. In
this stage, Photoshop is a very important tool since it

Line it up: Bringing your model into
Photoshop and set the Surface Style
to Line (from the 3D Scene menu) so
you can line it up with the grid
however you want, is the method
that Juri Jablokov recommends

Paint it: Now you can paint. "Switch
between 3D and 2D views in difficult
areas and remember to make new
layers according to your needs,
says Jablokov

Make a matte: Later on you can fill
this part of the image with a
background painting. It's probably
best not to do this straightaway,
because you might decide to change
your camera angle

® Frédéric Miller
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HOW TO ADD A TEXTURE

JURI JABLOKOV EXPLAINS HOW TO ADD AND FIX TEXTURES IN PHOTOSHOP

U 1 OPEN THE 3D RENDER

a photograph into a new layer above the 3D layer
and merge it down to project using Ctrl-E key
combination. This projects the photo onto the 3D
moadel taking in account the maximum projection
angle that you have set in the 3D menu.

ADD BACKGROUND AND TEXTURE

03

First, open up your 3D render. Then "bring

2 USE LAYER MASKS

0 It won't fit perfectly, so zoom In close
and see how the texture is applying. To fix any
problem areas, simply use Layer Masks. "Always
be sure of what layer you are painting on,” warns
Jablokov. “You cannot see the layer name if you

have only the 3D window open.

Jablokov's workflow often involves putting a "gradient background into the Environment

menu's background slot and set it to panorama mode so | would have some background to relate the
colours to.” This is a Photoshop render, but sometimes he exports back to Blender and renders from

there. Finally, add background texture.

helps me to extract several map types out of the
textures | use for the diffuse colour. | can easily

manipulate them with Curves to get a reflectivity map,

or extract the very fine detail by applying a High Pass
filter in order to get a detailed bump map.” Using
Photoshop's 3D tools Koch paints textures using and
says ‘| find the distortion tools great for adjusting

textures accurately to the model UVWS, creating all the

necessary texture channels (Diffuse, Specular, Bump,
etc.) and grouping them into folders gives me a
non-destructive workflow that allows me to make

quick and clean comrections. The save to layers script
is great to be able to export my layers without
collapsing them, giving me the option to come back
to Photoshop for fixes.”

But it isn't just what Photoshop can do that makes
it vital to the 3D artist's workflow. Koch says he uses
Photoshop "also as an excuse to be able to exit the
Operator mode and be able to see in a more critical
point of view, add comments, make some fast
retouches with Photoshop using other pictures,
allowing me to see my composition as a whole.”

WHERE TO FIND FREE
3D ASSETS TO USE

IN PHOTOSHOP

SKIP HOURS OF MODELLING AND
DOWNLOAD THE MANY FREE 3D
MODELS THE INTERNET HAS TO OFFER
(JUST MAKE SURE YOU OPT FOR A
PHOTOSHOP-FRIENDLY FORMAT)

1. TURBOSQUID

www.turbosquid.com

TurboSquid is probably the most famous collection of
3D models on the internet, and they're used in games,
illustration, visual effects and much more. Many of the
models are for sale, but there are lots of free treats to
browse through too.

TF 30
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2. TF3DM

www.tf3dm.com

A source of textures and tutonals as well as models,
TF3DM is updated regularly, meaning that there's
always something new to have a look at. Again, it
also has models that can be purchased.

/ =

3.CGTRADER

www.cgtrader.com

With categories like cars and food, there's a good
chance you can find what you need for free on this
website. There's also a forum, a blog and a gallery to
keep you sticking around.

4. ARTIST-3D.COM

www.artist-3d.com

It's .obj and .3ds files that dominate this 3D model
site, and it's got plenty of categories, including people,
vehicles and military items.
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3D TECHNIQUES IN PHOTOSHOP CC

3D PRINTING
SERVICES VIA
PHOTOSHOP CC

NO 3D PRINTER? GET YOUR 3D
DESIGNS PRINTED VIA THE CLOUD

1. SHAPEWAYS

www.shapeways.com

One of the first players in the 3D printing game,
Shapeways also has a marketplace so you can sell the
jewellery, toys or art that you have designed. You can
pick from plastics, metals and ceramics to print with.

RUN A FACTORY

2.SCULPTEO

www.sculpteo.com/en/

Sculpteo too has a marketplace where you can sell
your 3D printed products. There are different design
guidelines, depending on what material you want to
print with, but the site has plenty of information to
make sure your models pass muster.

i s Byl ot

. 3D Printing for Students

3. .LMATERIALIZE

www.imaterialize.com

An online 3D printing service for anyone with an eye
for design. You can turn your ideas into 3D printed
reality. Then share it with the online comminity.

4. MAKERBOT

www.makerbot.com

The MakerBot 3D Printed Products service allows you
to order from as few as 50 units of your design, or,
alternatively, you could splash out on a MakerBot
Replicator and print as many or as need as you need.

Not everyone has the time, money, or inclination to
master 3D modelling. And if you want to be able to
import 3D models into your own work but also be
able to manipulate them sufficiently so they feel
like they're yours, well, Photoshop CC can do that.
Mayers thinks this is a great way of working: “It's a
bit like using stock photos because someone else
has already done all the hard work in creating the
model. | used this method of importing several
models in my piece Future City. The imported
models were used in a way not originally intended
to create the buildings. Many 3D models come
supplied with Photoshop textures or bump maps; if
not you can use an app called UVMapper which
enables you to create texture maps based on the
object’s UV coordinates. Photoshop also allows you
to modify or update your textures on 3D models in
real-time, which is a great feature.”

According to Koch, another “interesting trick is to
use basic 3D objects for retouching complex photos,
aligning objects in perspective and using them to
generate depth maps to give depth of field effects or
volumetric depth fog, these layers will be rasterized

and then deformed to fit precisely with the

picture. This trick is extremely interesting for
texturing photos too! giving some dirt on walls or
even a adding details like dirt, mud, rust to a car for
example, it could have many more applications, it is
just a matter of experimenting with it, | find this
technique super interesting to give final details for
the finishing process.”

Because no matter how good a model you've
built, or how expensive a model you've bought, the
finished result can still look lifeless if you can't
wrangle Photoshop properly. Fawke notes: ‘It is
your job as an artist to be creative in bringing the
image to life. Photoshop has a wealth of adjustment
control to help transform your 3D renders (produced
in or out of Photoshop). Try new things, experiment
with agjustment layers, add colour, change blending
modes, use your masks. Emphasise your lights and
shadows. The biggest tip | can offer is to always look
at reference matenial. Materials and light react
differently than you may think. Look at the contours
of edges, study reflections, then tweak settings, play
around and try to replicate what you see.”

© Cris Koch

© Andrei Lacatusu
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‘ ‘ It is your job as an artist
to be creative in bringing

the image to life. Photoshop
has a wealth of adjustment
control to help transform your

3D renders (produced in or out
of Photoshop) 72
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SEE PAGE 8
FOR THE LATEST
NEWS ON
PHOTOSHOP'S
3D TOOLS

1S 3D THE FUTURE OF PHOTOSHOP?

THE FIREFLY COTTAGE BY IFTHIKHAR ABDUL NASSER

IFTHIKHAR ABDUL NASSER EXPLAINS HOW HE TURNED DAY INTO NIGHT WITH PHOTOSHOP

"I once had a dream of millions of fireflies or
lightning-bugs, lighting up all around my house,”
says Nasser. “| fancied them to be stars that took
life and came down from the skies spreading all
around my home. Here | tried to re-create the
same dream in 3D and Photoshop.” As a
challenge to polish his Photoshop skills, he
rendered a day scene in 3ds Max and then
converted it to night within Photoshop. For
lighting, he uses different brushes, mostly default
and some custom ones of his own making.

() Matt Kohr

His lighting workflow depends “on ‘render
elements’ (like lighting pass, ID pass, reflection/
refration pass) that are generated along with the
main render for effectively controlling various
aspects like controlling lighting in the renders,
including independent light contribution from each
light source (specifically in interiors), global
illumination in the scene, reflection and refraction
on glass elements, shadow passes allow fine
shadow control, using the various overlay options
in Photoshop.” Photoshop allowed him to select

the individual objects in the render easily, and it
could work on them individually to enhance the
whole scene.

Nasser also textures and creates environments
in Photoshop, but setting himself the challenge of
turning day into night using only Photoshop shows
how powerful it can be. He says he uses the
program to “create that extra fine lighting for my
render, which gives the final touch or sometimes
making up for even serious emrors made if any in
3D. So | guess it helps to a good extent.”

© Ifthikhar abdul nasser

© Mark Mayers



Many artists are wondering if Adobe will further
develop Photoshop's 3D capabilities. Muller notes,
that “For instance, if you need very high resolution
textures, you split the UVs of your 3D model over
several UVTiles (so you would have for example, four
UV tiles instead of just one). Photoshop does not
seem to be able to cope with that, it only knows
1UVtile, so if you paint on your model it will paint
the same stroke over all your UV tiles... | am very
curious how Adobe will continue to develop the 3D
Tools in Photoshop and will be watching closely to
any changes that would make it more suitable for my
purposes.” With more and more people
experimenting with 3D printing, that's certainly one
direction Photoshop is heading in. “The most
important trend is related to the new technologies
that are improving as we speak,” says Lacatusu. “And
| am talking about 3D scanning and 3D printing.
These processes are great because they actually
create a palpable connection between reality and the
virtual world.”

Again, it's all about being real, or realistic anyway.
“To be effective,” Lacatusu adds, “you should know very
well when enough is enough. If there is not that much
time you can stop adding too much detail directly from
3D, and add it instead in Photoshop. Some details can
take a very long time to make in 3D, but can be very
easily implemented in Photoshop, and with much
more control.”

Ultimately, 3D i1s a great tool, but as Kohr notes,
“only when used carefully. It works best in service of
your painting skills not as a crutch to avoid drawing in
the first place. I've spent many years learning to draw
linear perspective, and to paint lighting. This is an
essential foundation. But if you're willing to put in the
time to learn proper 3D software, you'll undoubtedly be

happy you did.”
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4
OUR EXPERT
ANDREI LACATUSU
. andreilacatusu.tumblr.com
4 Andrei Lacatusu is a self-taught
E graphic artist, living in Bucharest,

Romania. He specialises in 3D

graphics and currently works as

lead CGl artist at Carioca Studio,
N in Bucharest.

i SOURCE FILES

| All the files used in this tutorial are
available on FileSilo, including the
32-bit raw render, the render
passes and the background photo.,
The textures can be downloaded
free from CGTextures.com
(DecalLeakingRusty0002_1_M and
MetalScratches0079_4_L).

MASTER 3D POST-PRODUCTION

B BEGIN COMPOSITING AND POST-PRODUCTION

READY YOUR FILES TO START ENHANCING YOUR 3D RENDER

0 1 ‘ PLAN THE WORKFLOW
Having completed the render, it is now
time for compositing and post-production. It is

1]
always essential to know how much you can get };\:'-\?géggs 5
directly from 3D and how much can you add
g e | FROM RAW RENDER
later, and in this case, the plan is to change the TO FINISH

background and enhance the image with the
render passes, and add some more detail by
using textures in Photoshop.

OVERVIEW THE FILES
0 This render was completed in Autodesk’s
3ds Max using the V-Ray render engine, but almost
all 3D software offers you the possibility to render
several passes, or render elements as they are called
in V-Ray, in order to help during your post-production
process. In this case, the documents consist of the
main render, Alpha channel, Reflection, Specular, Raw
Total Lighting, Wire Color and Normals.

Progress 1: Have all your
files ready

Vo,

L]
%

\.‘ p’ Progress Z: Create
e - . ‘l advanced masks
-~ W

- .-l'

o

03 USE THE WIRE COLOR

The Wire Color pass is extremely
useful, because it has all the separate objects
that were rendered, coloured differently. This
makes it very easy to make selections that
otherwise would be time-consuming and
tricky to achieve. This method of selecting
objects will be used intensively while
post-producing this image, in the next stages.

Frogress 3: Add texture detail
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04 USE THE ALPHA CHANNEL

‘ The Alpha Channel is a black-and-white
render pass, which allows us to create precise
masking for our main object. Add the 3D raw render
layer to a group, in this case called 3D. Then load the
Alpha Channel in the document above all layers, go to
the Channels tab and Cmd/Ctri+left-click on the RGB
Channel in order to make a selection. Go to the group
layer and click on Add Layer Mask. It is better to have
the main image in a masked group, because all the
following layers that will affect the 3D render will
automatically be masked.

W QUICKTIP

You should always know what your limits are and
how to achieve the best result in the most efficient
way. In this project, a lot of time was saved by
adding detail and illumination in Photoshop
instead of trying to do it in 3D software.

07 ‘ USE THE REFLECTION PASS

The Reflection pass is widely used in
post-production, and it can make your image really

pop out. Add the Reflection image to your document,

in the 3D group, and choose Color Dodge as the
blending mode. Screen mode is often used for this
stage, but in this case it washed out the image a bit,
while Color Dodge brought more contrast. The
Image now is overly bright, so you have to mask the
Reflection layer and fill the mask with 50% Gray.
Select the mask and go to Edit>Fill and choose 50%
Gray. Now you can paint the mask with black where
you think you need less reflection and with white
where you think it's better to intensify it.

0 5 ADD A NEW BACKGROUND

To have more detail on the background, it
iIs better to replace it with a real photo. The difference
won' be striking, but the eye will perceive it as being
realistic. Place the background image as a bottom
layer, and tweak the layer by adding a Curves
adjustment layer, in order to integrate it with the 3D
mechanical type. The image seems to be a little bit
desaturated all over, so add a new layer between the
background and the Curves adjustment, filled with a
light blue and set at low opacity and with Color as
the blending mode.

ADD THE SPECULAR PASS

08 The Specular pass is a representation of
specular highlights on the rendered surfaces.
Similar to the Reflection pass, you can use it to
bring out more some highlights of your rendered

06 ADD SHADOWS

The mask is also covering the shadows
underneath the main object. 3D software allows you
to render passes that contain just the shadows, but
in this case the best choice is the Raw Total Lighting
image. Add this to the document, above the
background and under the 3D group, and choose the
Multiply blending mode.

object. You need to blend this layer by using the
Screen mode, which is most suitable in this case.
But on other projects be sure to check more
blending modes from the Lighten category, some
might work better than others.
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B EASILY CREATE ILLUMINATION MASKS

BRIGHTEN AND DARKEN PARTS OF YOUR IMAGE BY USING THE NORMALS PASS

0 USE THE NORMALS PASS

This render element is a 2D representation of the 3D objects, based on the normal angle of

the camera. The image is made up of tones of red, blue and green, which represent the axes of the
tri-dimensional space (x,y and ). Although often ignored, it can be used to easily create masks, being
based on RGB values,

DA TE

lace it as the top layer in the 3D group.

We will make masks with it, so it is better
to sit at the top so it is easy to access
throughout the rest of the process

1 1 OBTAIN THE DESIRED MASK

The image needs more light coming from
above, and instead of going back to the 3D scene,
making tests, rendering again and losing several
hours, you can use this technigue, and have an
undestructive and controllable tool at your disposal.
In order to obtain the desired mask, play with the
Hue/Saturation options - the values that work best
are +30 for Hue, +100 for Saturation and -30 for
Lightness. You can see how the surfaces that face up
are all covered in white, while the rest of the image is
black, which means we can use this result to
illuminate from above.

R%ZJU%?HENT LAYERS

Link a Hue/Saturation adjustment
layer to the Normals pass, and also
add and link a Channel Mixer
adjustment layer above it

CHANNEL MIXER

Set the Channel Mixer on
Monochromatic and reduce the Red
value to the minimum, and then raise
the Green value to the maximum

1 2 PUT THE MASK TO GOOD USE

‘ Go to the Channels tab, and click while you
hold Crd/ Ctrl pressed on the RGB Channel to select
the white parts of the image. Go back to the layers,
deactivate the Normals layer, and add a Curves
adjustment layer while you still have the selection
active. Pull the curve up to the maximum, and you
can see how the object gets brightened just as it was
intended. The image looks overexposed in some
areas, and also some regions might be better off
without the Curves adjustment. Therefore, group the
Curves adjustment layer and add a layer mask to the
group. Invert the mask and paint with the brush only
where you want the adjustment to affect the image.

1 0 ‘ CREATE MASKS WITH THE NORMALS PASS

The Channel Mixer already offers a
greyscale mask, but in order to have full control of
this technique, you have to use the Hue/Saturation
adjustment layer. As you move the Hue slider, the
image changes, just like if there is a light source that
moves around the object. Also, both the Saturation
and the Lightness sliders can be used in order to
play with the contrast of the mask. This technique is
extremely efficient, because you can rapidly create
masks to act from whichever direction upon the
rendered object.

Always group your
“ adjustment layer, and

add a layer mask to the group
to paint over it, so that you
can have maximum control
over your work 37

‘I 3 | REPEAT THE PROCESS

You can always reactivate the Normals
layer and tweak the Hue/Saturation settings until
you get other useful masks. You can direct your
curves to affect surfaces from every side you wish,
and you can also darken areas, not only brighten
them. Always group your adjustment layer, and add
a layer mask to the group to paint over it, so that you
can have maximum control over your work.



B ADD DETAILS WITH TEXTURES

BLEND TEXTURES OF RUST, GRUNGE AND SCRATCHES TO BRING REALISM

1 4 ‘ FIND THE SUITABLE TEXTURES

The image has some detail of extensively
used and grungy metal, but it lacks some logic in its
wear. To achieve that feeling, the best way is to add
some rust leaks, some edge wear and scratches.
To do this directly from 3D would consume a lot of
time. Besides that, adding this sort of detail in
Photoshop has the advantage that it is not
destructive and it is easy to control. A great source
for textures is CGTextures.com, a website that
offers a wide array of images, which can be
accessed for free. We downloaded a PNG decal of
rust leaking, which has enough variation and
information to be used all over the image.

ADD EDGE WEAR AND SCRATCHES

1 7 ‘ The texture is ready to be blended, but you should first make
a plan and think where this effect should appear: on the edges, at
some joints, and the scratched part on some plain surfaces that lack
detail. Place the texture where you think it suits best, and choose
Multiply as blending mode. Make a selection by using the Magic Wand
and the Wire —=, and add a layer mask to the texture layer. Now you
can paint with black on the mask and keep only what you think is
necessary to look good. Repeat the process and apply the texture

wherever it suits the purpose.

B RENDER PASSES

This tutorial explains some techniques and the use of some render
passes in order to enhance your rendered image. These techniques,
though, might not work in the same way on every project, and could
need some more tweaking. There are also some more render
passes that can help you in post-production, to add depth of field,

1 ADD RUST LEAKS

5 ‘ Before starting to add the leaks, you should
identify the best spots to add them: under objects, at
joints between objects, at the top part of some
objects. After placing the texture, you should use the
Wire Color pass, and select with the Magic Wand the
object you wish the texture to be applied to. Mask the
texture with this selection and paint with black on the
mask covering parts of the rust leaks. Repeat this
process until you cover all the places you think there
should be leaks.

B QUICK TIP

‘I 6 ‘ PREPARE THE TEXTURE

For this process, | downloaded another
texture from CGTextures.com. This image is
suitable because it contains both a grungy wom
edge and also some scratches. Now the image is
coloured and cannot be blended, so you should
desaturate the texture and add contrast to it. In

order to do this fast, while you have the texture
layer selected, press Cmd/Ctrl+Shift+U to
desaturate the image, and then Cmd/Ctri+L to
bring up the Levels adjustment. Now pull the white
and black Input Levels sliders closer to the centre,
until you have quite a contrasted texture to use.

Keep a balanced eye and don't over-edit your image. Especially in CGI post-production

where you have all these helpful rendered layers, you might be inclined to add and

blend layers too much. Always play with opacity, mask your layers and keep things as

natural-looking as possible

1 8 SHARPEN AND SAVE
‘ The image is almost finished, and it looks much better than the raw render.
Before saving, it is better to sharpen the image a bit, especially if the image is made for
print. Flatten the image, by going to Layers>Flatten Image, and then go to Filter>
Sharpen>Smart Sharpen and choose some small but effective values, like 100% for the
Amount and 1.5 for the Radius. Now the image is ready, so you only have to save your

fog and other effects, that can also enhance your images. _ . "
g d S image and enjoy your finished work! .
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HOW | MADE TECHNIQUES

_ ALTERNATE ENDING
~ MATHEUS LOPES

DISCOVER THE PROCESS BEHIND THIS BRIGHT, BOLD ILLUSTRATION PROJECT

razilian artist, illustrator and art director love with the art industry and decided to bet all my would be if the Hiroshima bomb had never fell upon

Matheus Lopes (www.mathiole.com) coins into it. When | was at college, graduating as a them, or if the bomb was simply an explosion of

created this award-winning design for a graphic designer, | started developing t-shirt colours, that brings joy instead of destruction

competition on Threadless. He's been designs for many companies. It worked so well for To create this colourful image, Lopes combined
interested in design for a while - " 've been working me that |'ve been in this held ever since.” Ilustrator with Photoshop, and used clipping masks
lon] and leaming design and illustration since | was 14, The idea behind Alternate Ending was "how to add the hand-drawn look that characterises much
when | entered a comic drawing course. | quickly fellin  different the world - and especially Japan - of his work

When | was at college... | started developing t-shirt
desiens for many companies. It worked so well for me
that I've been in this field ever since

A/ VA

Ilf 4

; 02 DRAW THE LINES
/ | imported the sketch to lllustrator,

> changed its Opacity to 30%, locked the layer and
started drawing the lines using both the Pen tool
and the Brush tool.

— ) 3 o 03 ADD SOME COLOUR
— ' Y : With the lines done, it's time to colour the

h_ shapes formed by the lines. Select all, hit K for the
Live Paint tool, and simply click on the areas. | dont

U 1 CONCEPT SKETCH
| made a basic sketch in Photoshop using
the Hard brush, to get a gimpse of the composition worry about the combination of colours now, I'll be

and to know where to trace the lines in lllustrator aple to change this later in Photoshop
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TECHNIQUES HOW | MADE

EXPORT TO PHOTOSHOP

Now | go to File>Export>Photoshop and
choose either CMYK or grayscale, 300 dpi, mark
Write Layers with all boxes checked and hit OK.

GROUP THE COLOURS 05

| decompose the layer where | used Live Paint, ungrouped it twice, deleted (or hid) the lines, and
started grouping (Crmd/Ctrl+G) shapes with the same colour, and put each group on a different layer.

CLIPPING MASKS

A POWERFUL WAY TO ADD
COLOUR AND TEXTURE

PpPINg MaskKs are a greal way (0 aad colour

and texture and they give you full control of

vhere they show up. Clipping masks literally
p to the layer below them, following the i 1dpe
L. Iry applying a clipping mask over a big

brushstroke tor a really creative eftect

06 USE THE CLIPPING MASK

Once the file is in Photoshop, each group of colours is on a different layer. | imported a custom
watercolour texture into the file, put the texture above the layer, held Alt and waited for the icon to appear.

| click and the texture will be clipped in the shape of the layer below. | repeat the process with the other
layers until they're all filled with the textures.

- Limpcm——
O ey

(EEIEZEZIETEIT

07 MORE COLOURS
| start playing around with colours in many

ways. The way | like most is selecting a layer and
hitting Cmd/Ctri+U to go to Hue/Saturation. | change 0 ADD THE DETAILS

values without too much thinking, this phase I1s Once everything is done, | add some details to enhance the image. On this one | added a paper

experimental and will make you go back and forth texture by simply putting it above all layers and changing the blending mode to Multiply. | also added a
until you find the right tones, splatter texture below all layers and thats it!
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CREATE A DISPLACEMENT EFFECT TECHNIQUES B

CREATE A
DISPLACEMENT

EFFECT

BREAK DOWN AND RECONFIGURE A PORTRAIT USING
SHAPE LAYERS, MASKS, AND LAYER STYLES

he artwork for Adobe Creative Suite 6
features stunning portraits flavoured with
the technology and culture behind the
associated program. lllustrator shows a
woman festooned with beautiful vector doodles. The
artwork for Photoshop, by Alberto Seveso, portrays a
face broken down and re-imagined using organic
shapes, elements, and texture. It's a prime example
of how Photoshop can help you produce complex

visuals with a layered approach.

Let’s try creating something in the vein of this
image. We'll start by using the Pen tool to layout
shape layers and adorn them with layer styles. This
tutorial assumes you have Pen tool basics down.

After compiling a decent array of shapes, we'll
extract our model and begin piecing together the
base forms using clipping masks. We'll continue to
add the shapes we made (and create more) to
build up the detail

Shape layers are extremely flexible and can be
reshaped with the Direct Selection tool. Shape
layers incur no degradation or blumness when they
are transformed, making them the perfect building
blocks for this tutorial.

For textural interest, we ll mask and blend in
some shots of foamy water and broccoli. To
finalise, we'll use a series of adjustment layers and
blend modes to get the perfect look.

B READY THE BUILDING BLOCKS

CREATE SHAPE LAYERS AND PREPARE THE MODEL

0 1 - CREATE SHAPES

Open Shapes.psd from FileSilo. There are a
few example shapes. We'll make some more. Create
a new layer. Select the Pen tool. In the options bar,
set to Shape and choose a Fill colour. Click and drag

on-canvas to create your shape. Create more
shapes. Don't spend too much time refining the
shapes though, as we can do that later.

03 ADD MORE STYLES
Inner Shadow can help bestow a bit more

heft. Use sparingly with low opacity, choke, and size.
Drop Shadow is key to building up the depth in the
piece. Be moderate with opacity and size, and
iIncrease when needed. As you stack and overlap
shapes, the shadowy interplay will create some nice
complexity throughout.

0 2 USE GRADIENT OVERLAY

Layer styles, accessible from the Layers
palette’s fx button, can add some quick dimension and
interest to our flat shapes. Apply a Gradient Overlay with
the Black and White preset for versatile dimension. You
can use a darken blend mode like Multiply, a lighten
mode like Screen, or a contrast mode like Soft Light.
Adjust opacity and angle as needed.

OUR EXPERT

ANDRE VILLANUEVA
000-000-0000.com

Andre fell in love with Photoshop
while studying web design in college.
He taught for several years in the
media arts department. He's now an
art director in Birmingham, USA.

SOURCE FILES

FileSilo contains the source files
needed to complete the tutorial:
blurs, shapes, foamy water shots,
and broccoli! Feel free to supplement
with your own textures and/or swap
out the model shot, which can be

downloaded from www.dreamstime.

com (image number 51969%06).

"WORKIN
PROGRESS

BUILD IT UP AND REFINE

Progress 1: Layer the
model forms

Progress Z: Add shapes and
more elements

Frogress J: Apply adjustments
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= 4

04 ‘ GROUP THE SHAPES
After creating a series of shapes, you can

start combining them to create new forms. You can
lower opacity and/or play with blend modes. Use Free
Transform (Crmd/Ctrl+T) to Scale, Rotate, and Distort
the shapes as needed. To help stay organised, put the
layers associated with these new forms in groups in
the Layers palette by selecting the layers and pressing
Cmd/Ctri+G. Now you can move all the layers by
simply selecting the group. You can also Free
Transform the whole bunch at once.

05 ‘ FREESTYLE IT
To create some sketchily dynamic forms

and streaks, grab the Freeform Pen tool and go
freestyle. Now, instead of plotting anchor points, just

click and drag to draw the shape. You can use your 06 PREPARE THE MODEL Select the Brush tool. With a soft round brush at

digital tablet if you wish, or you can just stick with the

Open the model photo then click the medium opacity paint white to enhance the lips.

mouse. You re bound to get some jagged and Create New Fill or Adjustment Layer button at Repeat with two Color Fill layers (#2ecc2a,
unrefined areas in the shape. Don't worry, these can the bottom of the Layers palette, choose Solid #1476d1) and blend them for the eyes. Now,
be a nice change of pace from the smooth and Color. Pick #e47fea. Set to Overlay blend mode. select the topmost layer and merge with Cmd/
regimented shapes you may already have in stock. Click the mask, press invert with Crnd/Ctrl+. Ctrl+Opt/Alt+Shift+E.

W QUICKTIP
In PSDs with many layers, it's imperative you organise things lest you

succumb under the sheer weight of a hundred or more nameless rogue
layers. Corral similar layers in groups. Add descriptive names. Colour-code a
group or layer by Cmd/right-clicking on its icon and choosing a colour.

Bl

\

07 MASHK THE MODEL

‘ Turn off visibility of all the layers below the merged layer. Select the Pen
tool, and set to Path in the Options bar. Plot anchor points to trace a path around
the model until you return to the origin. Next, refine the path. Wielding the Direct
Selection tool, zoom in around the path and smooth out any problem areas. When
complete, press Cmd/Ctrl+Return to convert the path to a selection, then press
the Add Layer Mask button at the bottom of the Layers palette. Now click Save.

4

BUILD UP MODEL FORMS
U Open Start.psd. Go to File>Place (Place Linked in CC), choose the
model. Drag in a shape you created and move it below the model. Create a
clipping mask by Alt/Opt+clicking between the two layers. Then Free
Transform the shape to fit. Make a duplicate of the model, drag another shape
below it, and create another clipping mask and repeat. You can move the
shapes independently. To move the model, first click one instance, Cmd/
Ctrl+click the other model layers, then press Link Layers at the bottom of the
Layers palette. You can now move all instances at once.



B BUILD ITUP

ADD AND ARRANGE SHAPES AND ELEMENTS

0 BUILD UP THE PIECES

After completing the base model forms, which serve as the foundation for the piece, we'll
supplement them with a multitude of coloured shapes adorned with gradient overlays, inner shadows, and
drop shadows. Building these up provides depth and detail.

001/ MODEL SHAPES

The base model pieces are built up
by using different shape layers to
contain the model photo via
clipping masks

ﬁ

1 ADJUST THE STYLES

You may also need to adjust layer styles as
you go along. By continuing to cluster shape layers
with shadowy layer styles, you may start to get areas
that are a bit too murky. You may also have areas
where a bit more shading would be nice. To edit a
layer’s style, double-click on the adjustment. For
Drop Shadow and Inner Shadow, adjust the opacity
and size up or down. For Gradient Overlay, you can
adjust opacity or even edit the gradient itself.

002 COLOUR SHAPES

The many coloured shape layers,
dressed with layer styles like Drop
Shadow, are overlapped to provide
complexity to the piece

003 | STAY ORGANISED

When working with many layers, use
groups to corral similar layers. Further
organise by nesting groups within a
parent group

-
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1 2 ‘ CHANGE COLOURS
As you continue to build up the pieces, you

may find that you need to change some of the colour.
With shape layers, it's a breeze to play with colour
possibilities. Simply double-click on the Color Fill
layer thumbnail and the Color Picker pops up.
Choose a new colour and click OK. In CSé+, you can
make sweeping colour changes. Crnd/ Ctri+click
each shape you want to change, select a Shape tool,
then use Fill in the options bar to change the colour.

1 REFINE THE SHAPES

Continue to move and adjust the pieces
with the Move tool. To assist you in finding
particular layers, you can tick Auto-Select in the
options bar and set to Layer. You will probably need
to manage the configuration of pieces throughout
the majority of the tutorial, since adding new
elements may necessitate you move, adjust, or
remove existing elements. Free Transform as
needed to Scale up or down, Rotate, or Distort. To
transform multiple shapes at once, Cmd/Ctrl+click
each layer, then transform.

‘ ‘ Shape layers incur no
degradation or blurriness

when transformed, making them
the perfect building blocks 39

1 CREATE SHARDS

3 | Let's create some shards. Go to File>Place
(Place Embedded in CC) and grab Mat.jpg then click
OK to confirm. Apply a layer mask by pressing the
Add Layer Mask button at the bottom of the Layers
palette. Click the mask then press Cmd/Ctri+l to
invert it. With the Polygonal Lasso tool, plot out the
corners of the shard until you reach the origin. Fill
the selection with white then deselect (Cmd/Ctri+D).
Unlinking the mask allows you to move and
transform the image or mask independently. Repeat
the process to add a few more shards.
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B COMPLETE THE BASE COMPOSITION

ADD TEXTURE AND FINALISE ARRANGEMENT

-I 4 ADD GLOW
We'll save the majonity of our colour

adjustments and glows for the end phase, but we'll
take a moment here to pause from our shape
building to add a bit of colour. Click the Create New
Fill or adjustment layer button at the bottom of the
layers palette then choose Solid Color - pick
#479784. Set the layer's blend mode to Screen.
Then move it up or down the layers’ stacking order
until you find a suitable position. Invert the mask
(Crnd/Ctrl+1), then paint it back with white and a
large soft round brush.

B QUICKTIP
We ve given new meaning to the term organic
food. To help lend an organic feel to the various

surfaces, we blended and masked some broccoli.

Be sure to keep a well-stocked and varied image
library within easy reach. You never know what

type of subject or textural qualities you ll need!

\ 4

B WORKING WITH SHAPE LAYERS

Shape layers can be created by using one of the

Shape tools or by plotting a custom shape with
the Pen tool (be sure to tick Shape in the options
bar). Whether you start with a geometric or
custom shape, you can edit the vector path by
using the Direct Selection tool. Click and drag on
the anchor points to adjust. You can use the Add
and Delete Anchor Point tools to add/delete
points on the path. These tools allow to you start
with stock shapes and make them your own. To
save a shape, go to Edit>Define Custom Shape.

‘I 5 ADD ORGANIC TEXTURE

We'll use some broccoli to add a touch of
texture. Place (Embedded) Broccoli.jpg above a
specific area, or simply place at the top of all the
current layers. Set to Soft Light blend mode. Add a
layer mask and then invert it. Paint back with white
to selectively apply the texture. If you need to peek at
the texture, you can Shift+click the mask to disable
(Shift+click again to enable). Place more broccoli in
other areas. To get a deeper blend, try a darken
mode like Color Burn.

1 7 ‘ FINALISE SHAPES

Add or create any last shapes to complete
the base composition. Layer some shapes at the top
to push the dimension. Paint some black in a layer
below to add shadows if needed. Also, go through
and see if any shapes and areas need to be moved or
altered. Don't be afraid to remove elements that don't
add value to your piece. If you're afraid to delete, turn
off the visibility until you can make a definite
decision. Zoom in and out, and use the Rotate
Canvas tool to help with your judgment.

1 8 MERGE AND BLUR

‘ With the top layer selected, press Crd/
Ctri+Option/ Alt+Shift+E to merge the visible
layers then right-click on the layer and choose
Convert to Smart Object. This will allow us to
apply Smart Filters to the merged layer. Go to

1 6 ADD WATER SWIRLS

Now we'll borrow some foamy ocean water
shots to add some interesting swirls to the mix.
Place (Embedded) Water1.jpg and position it in an
area where you want to add the swirl effect. Add a
layer mask, invert, then paint back with white to
apply. To better blend the swirls, you can drop the
opacity or try changing the blend mode (we used
Screen and Overlay). To add more swirls, duplicate it,
re-position, and adjust the mask. For some variety,
you can also use Water2,jpg.

Filter>Blur>Gaussian Blur. Set the Radius to 2.2
pixels and click OK. Restore some clarity in key
areas by painting black in the Smart Filter mask,
reducing the blur. If you want to adjust the blur,
double click on the Smart Filter, adjust the
Radius, and click OK again.



1 g SHARPEN IT UP

Press Cmd/Ctrl+J to duplicate the merged
layer. Drag the Smart Filter to the trash. Go to Filter>
Other>High Pass and set the Radius to two pixels,
then click OK. Set the layer to Overlay. Add a layer
mask, then paint black in areas to reduce the
sharpening. You might be wondering why we didn't
use the Smart Filter mask like the last step. By using
the layer mask, you can remove the sharpening and
provide a window to the underlying layer.

B QUICKTIP

Are you getting tired of swapping back and forth
between the Add and Delete Anchor Point tools

when adjusting shape layers? Just use the Pen

tool and tick Auto Add/Delete in the options bar.

Now simply click to add a point, or click on an

existing point to remove it.

2 ' ADD COLOURS

Now we'll fine-tune the colouring
throughout via a series of Color Fill layers. For
each colour you want to use, add a Color Fill layer,
choose the colour, then click OK. Invert the mask,
then paint back with white to add. Set the blend
mode to Overlay (if too intense, try Soft Light). You
can also lower the opacity to tone it down. Here
we added some greens (#6ed728, #56972a) and
cool colours (#11fcf9, # 1434f4), as well as a dark

flesh colour (#7e4ck4c).

APPLY MORE ADJUSTMENTS
23 We'll continue with a few more adjustment
layers that will refine the look. Click the Add New Fill
or Adjustment Layer button in the Layers palette,
then choose Gradient Map. Load the Photographic
Toning presets and choose Cobalt-Iron 2. Set the
layer to Soft Light, and reduce the Opacity to 40%.
Now add another Color Lookup layer, choose Foggy
Night. Set the layer to Multiply and drop Opacity to
50%. Paint black in the mask to reduce further.

2 0 OVERLAY BLUR

We'll now begin the final stage where we
really nail the look and atmosphere we desire, It's
advisable to create a group at the top to contain
these. You can turn the group’s visibility on and off to
see how things are looking. We'll use a series of
adjustment and fill layers, but first let's kick things off
by overlaying a blur shot. Place (Embedded) Blur.jpg.
Set to Overlay blend mode. Add a layer mask, then
paint black in areas to reduce.

2 ‘I USE COLOR LOOKUP AND VIBRANCE

Click the Add New Fill or Adjustment Layer
button in the Layers palette, choose Color Lookup.
Pick the Candlelight preset then paint black in the
mask to reduce in areas such as the main facial
features and the water swirl textures. Add another
adjustment layer, this time choose Vibrance. Max
out the vibrance, which increases the vibrancy while
protecting skin tones. For an extra bit of kick, you
can pump up the Saturation to +10 (or more). If
increasing, you can paint black in the mask to tone
down in areas.

2 4 USE LEVELS

Let’s brighten things up a bit. Click the Add
New Fill or Adjustment Layer button in the Layers
palette, and choose Levels. You can use the sliders
under the histogram to adjust the intensity levels of
Shadows, Midtones, and Highlights in the image.
Here we nudged the Midtones leftward, making a
gamma adjustment that lightens the overall image.
At the bottom, we moved the dark output level slider
slightly inward to limit how dark things can get.
Fiddle with the sliders until you're happy.
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MAKING CHANGES

SOMETIMES YOUR INITIAL IDEAS DON'T WORK OUT

Don't be afraid to make changes to a composition. In this case, the main
castle building was transformed from one style of building into another,
improving the painting by adding a stronger area of focus to both the city
scene and the image itself. The city now seems stronger and more
powerful because of the fortress at its centre, and the solid shape
encourages the eye to explore the surrounding scenery.
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CREATE A SCI-FI COMPOSITE FROM PHOTOS TECHNIQUES I

F"hovto‘%hrDiJ

CREATE A SCI-FI -2
COMPOSITE usacion g
FROM PHOTOS

EDIT AND COMBINE ORDINARY STOCK PHOTOS TO CREATE
A COMPOSITE ILLUSTRATION THAT'S OUT OF THIS WORLD

ci-fi cityscapes are often towering like Pixabay, Free Images and Unsplash that are
metropolises packed with futuristic perfect for sourcing cityscape photos. Try to
architecture, and you may sometimes make sure that all of the photos you choose are
wonder how to even get started with lit from the same direction, or choose photos that bUR EXPERT
llustrating one. Take a tip from the likes of Blade you can flip, rotate or warp to make sure that the JOE ROBERTS
Runner and use today's architecture as a basis. light's in the right place. Lighting 1s what makes JoeRoberts.co.uk
This tutorial demonstrates how photos of or breaks a composite. @Joe_R_Roberts
everyday buildings, environments and structures Once you 've assembled the requisite pieces - Joe Roberts is a digital artist based
. : _ _ in London, with 20 years experience,
can be edited and combined to create the city of look for towers, skyscrapers, and neon signs, as specialising in book covers and
the future in Photoshop. well as a suitable backdrop and sky —it's time to game art.
Start by assembling a portfolio of images. take your photos into Photoshop and use masking,
We've linked to images from iStock throughout adjustment layers and several other tricks to unify
this tutorial, but there are lots of free stock sites them into one futuristic cityscape image. = WORK IN
B SET THE BASIS FOR THE SCENE PROGRESS
CREATE THE BACKDROP AND SKY THEN START BUILDING THE CITY bt

Progress 1: Prepare for

0 2 ‘ ADD THE DESERT BACKGROUND e ot
Find a picture of a desert for the b

background (iStock 11662814). Scale (Edit> r_‘
U 1 ‘ SET UP THE SCENE Transform>5cale) and place the horizon just below ' '

Create a new document, with a background  the centre of the page, so that the viewer will have a

colour of #7bc7ee. At full size this illustration is slightly elevated position - above the streets but

235mm x 302mm and 300dpi = on some machines below the towers. This will also help the viewer

you may prefer to work smaller. This will help with read across the action. Go to Layer>Layer Mask>

processing, and also enable you to use medium Reveal All. Press D on your keyboard to select the

resolution comp images. You can download from colour black, and use the Gradient tool to fade the

sites like iStock and use these non-commercially. top of the photo to the blue of the canvas. i

add buildings

INSERT THE SKY

03 Find a picture of a blue but brooding sky
(IStock 10830462) for the top of the image. With the
Gradient tool, mask up this time, then give the mask
a more curved look by airbrushing out with black,
and back in with white. This is best achieved with a
Soft Round brush, with Shape Dynamics switched
off, and Hardness at 0%. Keep Flow low, at around
1%, and certainly no more than 10.

_

Progress 3: Make adjustments
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04 ‘ PREPARE FOR THE CITYSCAPE

For the foreground, something
desert-like and craterous should do the trick
(IStock 60036860). Mask the top. To give the
illusion of a landscape large enough to
accommodate a city, you'll also need to defocus it
slightly. With the layer selected, go to Filter>Blur,
and apply a Gaussian Blur with a radius of around
0.5 pixels. You can add a back wall to the crater
using a similar photo.

B QUICKTIP
Remember that you can flip and rotate the photos

(or parts of photos) that you're using so that the

light comes from a consistent direction - this
looks more convincing than painting in new light

over photos with different light sources

05 ‘ MAKE THE CITY'S BASE
The city is going to be built inside a 06 ‘ CREATE THE SPHERE
dome, so it needs to be sitting on an appropriate For the dome you need to start with a

base. Observatories provide the right kind of
structure (iStock 37792604). Using the Pen tool
create a path around the base, then in the Paths
palette make a selection of 0.3 pixels and
copy-paste it in. To remove any stray edges, go
to Layer>Matting>Defringe, then using the Blur
tool, with a soft brush of around Spx, quickly
work around the edge of the base. This scene
will be lit from the upper left, so consider that
when choosing photos. Now add a Levels layer,
clipped to the base, to deepen the shadows and
raise the highlights.

sphere. You can render one in Photoshop using 3D
tools, or use a stock image (IStock 30625584). Scale
and Place the sphere approximately where you'd like
the dome to sit (above the Base layer but below
Foreground), then add a Gaussian Blur of about 0.7
pixels. To make it look glassy, reduce its Opacity to
95% and change the mode from Normal to Soft Light.
So that the sphere can bulge a little at the bottom, go
to Edit>Transform>Scale, then in Warp Mode pull on
the points and handles to achieve the desired amount
of flex. Finally add a layer mask, and paint away the
lower parts of the dome that are not needed.

I mg B grale -

07 START TO ADD BUILDINGS

You now need a good selection of
buildings. It's important that the photos you choose 08 FINESSE THE EDGES results go to Layer>Matting>Defringe, then Blur
are shot from angles that are compatible with the Create a clipping path around a tool the edges. Remember that the main light
spectator’s view - looking down on structures building (IStock 2876631). Make a selection of source Is from the top left, so, if necessary, flip
nearer the base, but up towards the higher towers 0.2 pixels, and, beneath the Dome layer, copy the layer horizontally, by going to Edit>
that penetrate the dome. and paste it into the scene. Again, for best Transform>Flip Horizontally.



B ADD THE BUILDINGS

USE STOCK PHOTOS AND PHOTOSHOP TOOLS TO POPULATE THE CITY

09 I PRESERVE DATA WITH SMART OBJECTS

The city itself will be quite complex and you may want to go back and re-edit many elements,
many times, so to preserve the original data convert the Building layer into a Smart Object (Layer>Smart
Objects>Convert to Smart Object) then add a Gaussian Blur of between 0.2 and 0.6 pixels. You can now
change the amount of blur at any time by clicking the little arrow at the right of the layer title and double

clicking on Gaussian Blur.
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001!/ SMART OBJECTS
Convert all of the cityscape elements
to Smart Objects so that you have full
control over them and can rearrange

them if necessary any time

002 | SMART FILTERS
Once you've made
applied a filter, use the icon on the layer
palette to change the filter strength at

a Smart Object and

-I 1 ‘ INCREASE CONTRAST

If the building is looking a little faint now,
you need to up the contrast. Clip on a Levels
adjustment layer, with the black set at around 26
and the white at 245. It also needs to look a little
bluer, to reflect its environment, so clip on a Color
Balance layer and in Midtones set Cyan/Red to -8
and Yellow/Blue to +20.

o BRI 1 AR
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003 | CONSISTENT LIGHT
Flip or rotate some of your image
elements so that all the litht is coming
from the same direction. If light isn't

consistent the image won't work

1 2 ADD MORE BUILDINGS

Repeat this process with more
buildings and structures. Play with Levels, Color
Balance, and Blur as you go, keeping each
element within a certain range but varied
enough to appeal in an illustrative sense. If a
structure is looking too colourful, add a Hue/
Saturation adjustment layer and pull the
Saturation slider to the left as you see fit.

g @ SRR G DA D s T e e ey O e O
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REDUCE OPACITY

Reduce the Opacity of the Building layer to
around 90%. This will add an additional sense of
depth and distance, and lend the layer some of the
colour and tone of its environment. With all that
metal and glass in the scene, it will also create an
illusion of reflections. Now add a layer mask, and
pull a gradient up and over the base of the structure.
Ghosting this out helps further with depth, and as the
city comes together and it allows the buildings to be
moved around the composition freely without tearing
out their foundations.

‘ ‘ You may want to go back
and re-edit many elements,
many times, so to preserve the
original data convert the Building
layer into @ Smart Object 23
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1 3 SEPARATE THE BUILDINGS

‘ Sometimes, in an illustration like this,
elements can get a bit lost amongst those around
them. If that happens to any of the buildings, apply
a bit of misting behind its layer, to separate it
slightly. Select a brush like the one used earlier
and paint a subtle dusting behind the building.
With the Brush tool selected, pick a light colour
from the background, by holding down Opt/Alt and
clicking on a colour you like, Again you can keep
the flow at around 19%.
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B ADD THE FINAL FLOURISHES

USE ADJUSTMENTS AND CREATIVE EFFECTS TO BRING IT ALL TOGETHER

{
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i
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1 4 ORGANISE LAYERS

‘ If you haven't already, now would be a good
time to start organising your layers into folders -
things are about to get busy. Select all five layers
associated with Building 2, then click the Folder icon
at the bottom of the palette. Name the resultant
folder, ‘Building 2 Folder'. The reason you should call
a folder, folder’ is so that you can easily distinguish it
from its contents when right-clicking the image, as
sometimes you will have many layers and folders,
and folders within folders. Organise the rest of the
layers accordingly, including a Buildings folder for all
your individual Buildings folders.

B QUICK TIP

When using agjustment layers, you will achieve
tter results by stacking subtle effects, rather

than using a single adjustment at full strength.

Build up several adjustment layers to achieve the

=] TIE COLOURS TOGETHER

2N YOl u're addinc ' n high contrast st
to a sci-fi cityscay

ock photos
| .|'I. M 10 L- (==l J"-Ij ine
darker areas will disappear. This trick using
Screen mode is really useful and is used here not
'-*-"Ih many other
ients of the piece. Working with stock

)ges, the blacker t
ty, the neon signs, the atterburners and
ntrails of the vehicles, are all created

Even the mist and s

ichieved this

just on the waterfall but
» pelter, the ughts in the

using the

1 5 CREATE HEIGHT

Keep adding buildings and structures
until the city looks suitably dense. Once you are
happy with the composition you can start working
at street level. The same principles apply here but
you will probably find Transforming in Warp Mode
useful to establish a layout that fits within the
curvature of the base. Add a layer mask to your
Buildings folder, then very subtly mask away
some of the tops of the tallest buildings - just

enough to give them a look of misty heights.
ADD THE WATERFALL

1 7 For the waterfall, find a suitable image
with light water against a darker background.
Change the opacity mode to Screen, and you'll
notice that the darker areas start to disappear.
Clipping on a Levels adjustment and deepening
the blacks while nudging up the whites will take
this even further. Then it's just a case of masking
away what's left, while keeping any rocks etc that
you might want, for a cleanly isolated flow.
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1 8 ‘ FINISHING TOUCHES

Finally, create another Adjustments folder.
This one will sit nght at the top. Add a Color Balance
layer, select Shadows then pull the slider -15 towards
Cyan. The next Color Balance layer will be used for

1 ‘ MAKE ADJUSTMENTS

6 Create a new folder above Buildings, and
call it Adjustments. Create a Levels adjustment
layer, softly masked around the city, and use it to
increase the contrast slightly. Create a second
Levels layer and use it to increase the light levels,
then mask it so that it only applies to, in and
around the top right of the dome.
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the Midtones. Increase these slightly, particularly
the Green as this will help with some of the
organic elements without contradicting the desert.
Play with Levels, Vibrance, Brightness and
Contrast, until you find a look you are happy with. .
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The inspiration for Gravity Was being in
“ a place where you don't actually belong
and not knowing what you are doing 33*




TECHNIQUES | HOW | MADE

GRAVITY
RAPHAEL JIYA

DISCOVER HOW RAPHAEL JIWA CREATED AN OUT-OF-THIS-WORLD
PHOTOMANIPULATION USING PHOTO STOCK AND HIS OWN BRUSHES

alawian-born Raphael Jiwa (www. so after a while | searched for better software and what you are doing,” Jiwa explains. “l used the

elrafagiant.com) came to the UK at stumbled on Gimp. That relationship just didn't work  monkey in space trying to repair a spaceship in a

the age of eight and it was then he was  out so my ITC teacher introduced me to Adobe futuristic environment to illustrate it.”

introduced to a computer for the first Photoshop 7, and since then | have been designing Based mainly on using the Pen tool, his own
time. “[It was] love at first sight! After clicking my heart out.” custom brushes, Gaussian blurs, blending modes
around | found Microsoft Paint and | hated it, but “The inspiration for Gravity was being in a place and the Warp and Transform tools, Jiwa built this
drawing random stuff took me to a different place where you don't actually belong and not knowing image up from photo stock.

O‘I CUTTING AND MERGING 3 . e
| cut out the background of this image and 4

then used the Eraser to rub out the face. Then | used

the Clone Stamp tool to bring back bits of the helmet.

02 SETTING THE SCENE

| made the background with simple Brush
tools by making simple cloud-like effects and adding
gradient maps then merging to add a star pattern.

0 3 CONTROL CENTRE
| made the control centre in a different document and then dragged it in. | warped and skewed
it to fit the perspective then added a blue Outer Glow. .
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CREATE MOVIE-POSTER STYLE ARTWORK  TECHNIQUES B

CREATE MOVIE-

POSTER STYLE
ARTWORK

LEARN HOW TO CREATE A MOVIE POSTER EFFECT
WITH MOODY TONES AND SUPERHERO EFFECTS

here’'s something about a costumed

look to the skies, or to the movies, to
become inspired. When it comes to powers and
superhuman abilities, it's easy to get lost in the
theatrics of it all.

Creating your own superhero-themed

masterpiece is easy as long as you ground your work

in reality. Remember, there’s a fine line between
dramatic and melodramatic - don't cross it.

Use colour and light to your advantage. Warm
colours come forward, while cool colours go

W FIRST THINGS FIRST

ISOLATE THE MODEL AND WORK ON YOUR COSTUME

U 1 KNOW WHAT YOU NEED TO DO

Before you begin with anything, always
have your end goal in mind. What kind of effect do
you want to achieve? Go through existing movie
posters for inspiration and sketch a few designs.
Look for existing posters that catch your eye.
Don't be afraid to get inspiration from what'’s
already out there; anything that's dynamic is open
for consideration.
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U KEEP YOUR CLIENT'S SPECS IN MIND

Once you have a solid idea of how you want

your image to look like, apply your client’s

specifications to your design. How can your ideas fit
into what the client wants from you? Did your client

provide you with any starting images or specific
directions? Go with your creative instincts, but
always keep your client happy.

superhero that brings hope no matter how
bleak real life gets, but you don't just have to

backward. Bright areas attract your eyes first and
dark areas are easily overlooked. Use lines and
points of interest to keep the attention circling
around your image. Doing this will keep the
viewer's eye focused on the key elements, and not
wandering all over the page.

Always direct their attention to the most
important aspects of your image. Falling rain and
other effects can be distracting, so stay subtle and
keep it balanced. Sometimes adding too many
effects can break up clean lines that otherwise
allowed for an organic flow to the image. Read on
to discover how to create your own movie poster.

03 ISOLATE THE MODEL

Begin by removing the model from the
existing background. Hopefully, the model was shot
against a solid background. While green is often used
for video, a solid white is much better for compositing
Images because less work is required. If not, manual

masking will need to be done. First, silhouette the
entire model by using Filter>Color Range.

OUR EXPERT

JOHN ROSS

www.TheArtofRetouching.com
@ArtofRetouching

John educates photographers and
retouchers by helping them
expand their creativity through
Photoshop from his website, and
the classes he teaches from New
Haven, Connecticut.

SOURCE FILES

On FileSilo there are two cityscapes
to help you perfect the background
to your movie poster. You can
download the model photo from
www.dreamstime.com, image
number 36725883

“WORKIN
PROGRESS

WORR IN PROGRESS

General changes

». -
/- Detailed work

Refinements
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B TECHNIQUES CREATE MOVIE-POSTER STYLE ARTWORK

4 USE THE REFINE MASK WORHK ON YOUR COSTUME layer mask. Bring back the details of your selected
0 Apply this selection to a layer mask and use 0 Reselect your layer mask with Cmd/Ctrl area by setting the layer's blend mode to Multiply and
Select>Refine Mask to brush the fine hair details and click the layer mask you just created, it will adjust the opacity. Use Layer>Adjustment Layer>
back. If you have a strangely coloured background reselect. Darken the skin by applying the selectionto  Black and White. Tint with OR 198G 255B and pull
like green, then the Decontaminate Colors option can a new layer and filling the selected area with black. down all the colours to -200 except Red 88 for

help. Finally, use a small brush with 80% Hardness Remove the skin areas with a black brush on the enhanced contrast.

on the layer mask to paint away any areas that Color ne—— I

Range could not get. For silhouettes, you need to ™ 9 B o . 147% e, e -

come close and be accurate. Cut into the subject one

or two pixels to avoid the background colour. No one

will ever miss these few pixels. :

A

z

-
06 CREATE A GLOWING EFFECT 07 THE INKED COMIC LOOK

A trademark superhero usually comes While it's very popular to ground

with some trademark superpowers. Keep your superheroes as close to reality as possible these
hero superhuman by adding creative elements in days, it's still good to remember that they came from
the costume and around your model. Here, you the KAPOW-filled panels of your favourite comics.
can simulate a superhero glow with a white brush Stay true to your superhero's comic book origin story
on a new layer. For cleaner lines, use the Pen tool by keeping the inked effect intact. To achieve a more
instead, and stroke the paths you created. With contrasted and gritty comic look, go to Layer>
white colour for either tool, create a glowing effect Adjustment Layer>Curve with two points: Input 91,
using a Layer>Layer Style>0uter Glow with the Output 3 and Input 197 Output 214. This will help
following properties: Screen blend mode, 43% make your image look more reminiscent of your
Opacity, RGB values of 150R 219G 255B, 8% favourite graphic novel.

Spread, and a Size of 44%.
B QUICKTIP

You should always try to make things easier for
yourself from the get-go. Simplify your image by
addressing the basics first, such as isolating the

model. Then, create your costume and other
dynamic elements like glowing effects, all while
keeping your end goal and your client's
specifications in mind.

REMOVE GARMENTS UNDER THE COSTUME
0 A secret identity is best kept asitis - a
secret. Remove the undergarments of the original
model beneath the costume you have just created
once the basic look you're gunning for is achieved.
Create a new blank layer right above the model
layer. Because of the previous Curve, you will no
longer need to be accurate. Still, you should try to
match the general skin tone with a paintbrush and
cover over the fabric areas. With some tone
sculpting, you can adequately remove those old
clothes under the costume.
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W THE OVERALL FEEL

ADD DYNAMIL E

0 WORK ON YOUR BACKGROUND

EMENTS LIKE CITY AND SKY LAYERS, LENS FLARES, AN

IEATURES

You can either achieve a subtle yet effective impact with your cityscape, or you can run the risk of
going overboard. It's important to find the right balance, as you don't want your dynamic elements to
overshadow your superhero. So be sure to keep the background sharp, but subdued. This can be achieved

by using a slightly lighter black to show distance.
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BACKBROUND IMAGE

Place city.tif behind the model layer,

removing the blue sky with the Magic
Wand. Scale this layer to fit correctly,
making the buildings look realistic

‘I MAKE COLOURS POP

As your image comes to life, you can
make selected colours pop by using
Layer>Adjustment Layer>Vibrance. Take a moment
to further understand these two sliders. Vibrance
will first affect the cool colours like blues, while
Saturation is quicker to affect the warm colours like
reds. For this image, you can easily adjust the
model’s hair and face with subtle adjustments to
the Saturation slider. When you're satisfied with
your results for the warm hues, compensate with
Vibrance as needed. Brighten overall with Levels or
Curves, and touch up with a cloned layer.

ﬂ[g I SELEI%T YOUR
H:lr achXEﬁect. place a moody sky

hoto behind the cityscape. You can use
DR software like Photomatix from
www.hdrsoft.com to bring out the detail
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003 | MATCH THE COLOR

#&HEI E-Eey aﬁang layers from

different sources, it's important to
keep them all balanced and use the
same tones and colours

‘l CREATE VISUAL INTEREST
You can make the most out of the various
visual elements in the photo, so don't be afraid to

experiment with the different warm and cool colours.

Add some soft details in the hair by using a new
blank layer, and a very small brush set to 10 or 20%
Opacity. All these are good ways to adjust colours as
the light bounces around. Select hues that are
already in the image by using the Eyedropper tool.
You can also paint in highlights and shadows
depending on your taste.

-

1 0 ADD SOME BRICK

Place brick.tif (on FileSilo) below the city
image. Use Edit>Free Transform to scale it to fit,
and rotate it -4.70 degrees. Use Layer>New=>Layer
and paint in with a black brush at 20% Opacity to
add some depth, with a shadow under the pool rim,
under the model’s feet, and above the edge of the
image. You can add some extra detail with
Filter>Filter Gallery=Film Grain with values of Grain
4, Highlight 0, and Intensity 0.

‘ ‘ Tone trumps colour. If
the image looks

balanced in greyscale, it will
look great in colour 97

1 BALANCE TONE AND COLOUR

The face needs to be bright because it is so
important. Just be careful to have it match the overall
scene. Place a temporary Layer=Adjustment
Layer>Black and White over the top, and you can
check your tones. Tone trumps colour. This means
that as long as the image looks nice and balanced in
greyscale, it will usually look great in colour. Make a
selection around the hair and face, then use Layers>
Adjustment Layers>Exposure with values +1.89
Exposure, -0.1313 Offset, and 1.03 Gamma.
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W ALIGNING WITH YOUR END GOAL

ADDING FINISHING TOUCHES TO CREATE THE PERFECT MOVIE POSTER

1 LOOK AT THE BIG PICTURE

Because you are working on a superhero
piece, there is a tendency to add too many effects
and too many adjustments. But creating a heroic
piece does not mean you should use every effect
that Photoshop has to offer. To avoid getting your
nose too deep into the details, detach yourself, take
a step back, and look at the big picture. Zoom out,
Inspect your image, and make sure everything is
still well balancea. It's easy to add too much detail
with the effects.

B QUICKTIP

Superhero movie posters may have unrealistic
elements set in a realistic world, and it's up to
you to find the right mix of making something
fantastic yet believable. Just be sure to keep the
focus on your main hero and not on everything
else going on around them.

B MASKING, ADJUSTMENTS, AND
NON-DESTRUCTUVE WORKFLOW

Masking is one of the most important and basic
skills you need to have when doing any
retouching work, especially when you're
working on a composite piece like this one.
Because the elements around the model are
dynamic and changing, working non-
destructively is now more crucial than ever to
allow you to go back and forth between your
adjustments in case you change your mind at
any point while working. For more on masking
and how to work non-destructively, go to www.
TheArtofRetouching.com for more in-depth
tutorials on everything you need to know to
become a master retoucher.

1 KEEP THE VIEWER FOCUSED

5 Movie posters always keep the viewer's eye
focused on the central image. In this case, you want
your viewer to hone in on your superhero model
right away; even with all the fancy glow effects and
smoke layers in the background. To ensure that you
can eftectively direct your viewer's attention,
remember that the brightest areas keep eyes
focused. Despite all the textures and swirls pulling
your eye around, it is always brought back to the
centre, which is where your superhero should be.

1 OUT OF GAMUT

Colour settings are completely different for
online images, when compared with printed images.
In prints, you may find that the final image has Out of
Gamut issues while working in RGB (Red, Green and
Blue). That means the colours are so bright and pure
that the magazine’s printing process will lose details
because it cannot reproduce the colours accurately.
By carefully reducing the Saturation, the colours can
be brought closer to the CMYK (Cyan, Magenta,
Yellow and Black) colour model that magazines use.

1 LET IT RAIN

You can add some extra texture by
adding the storm's rain to the picture. Creating
rain is easier than you may think. Simply create a
blank layer with Layer>New=>Layer and fill it with
black. Use Filter>Noise>Add Noise with a value

1 USE COLOUR PALETTES SPARINGLY

Notice that the current movie posters out
In cinemas today often use limited colour palettes.

When you want a particular element of your
image to stand out, then using a new colour will

help. Whenever a different colour is introduced, it

I5 used as a way to draw attention to it. Thisis a
powerful tool to control what you want your
viewer to notice. Here, it is the face, hair, and sky

that have the only red, yellow and orange colours.

Ultimately, the only warm elements.

b

of 50, uniform and Monochromatic. Then apply
Filter>Blue>Gaussian Blur with Radius of 0.50.
Lastly, use Filter>Blue>Motion Blur with Angle
60 and Distance 50. By doing this, you will
enhance the mood of the storm by getting
everything wet.
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TIPS, TOOLS AND TECHNIQUES 10 RELP YOU IMPROVE YOUR SPEED AND WORKFLOW
IN PHOTOSHOP, WITH ADVICE FROM PROFESSIONAL DESIGNERS AND ARTISTS




25 QUICK TIPS FOR PRO DESIGNERS TECHNIQUES B

01. RELIGHT SCENE ELEMENTS FAST WITH QUICK MASK
MATTE PAINTER AND CONCEPT ARTIST JACEK PILARSKI (WWW.JACEKPILARSKI.COM) EXPLAINS
HOW HE USES PHOTOSHOP'S QUICK MASK FUNCTION IN HIS ENVIRONMENT DESIGNS
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Jacek Pilarski
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01 ‘ SELECT ELEMENTS TO RELIGHT
The first step in relighting elements is to
select the [layers] we will work with. You can also
put a black layer in the bottom for better separation
from other elements. We use the keyboard
shortcut of Crnd/Ctrl+Opt/ Alt+Shift+E, which
creates a new layer out of all the visible layers.

™.

02 CREATE THE SELECTION 03 USE THE SELECTION AS A MASK

Next, use Cmd/Ctrl+Shift+U to convert it into B&W mode. Play with While your selection is still visible, create an adjustment layer and the
Curves (Cmd/Ctrl+M) and try to manipulate the sliders to get the desired mask will be created along with it automatically. To keep a non-destructive
black-and-white mask. When you're finished, use Crd/Ctrl+A to select and workflow put this adjustment layer into a folder and create a mask on top. Hide
Cmd/Ctrl+C to copy our layer. Hit Q to go into Quick Mask mode and use Crmd/ it by inverting the mask and use a brush to reveal the elements you want to
Ctri+V to paste the layer. Press Q to quit Quick Mask mode. change in your work.

02. FASTER PAINTING TRICKS

Freelance graphic designer Wendy Stephens (www.darkirisdesign.co.uk) talks us through her
workflow process, building up digital paintings quickly and effectively

Layer mask: "l then add a layer mask
and start reducing the overall
pinkness ? painting black. luse a

' soft-edged brush and set the Dpacity
Start in greyscale: “The biggest to 5% so | really have gentle control
time saver for me was discovering over how much of the original
painting in greyscale before adding : greyscale layer shows through”
colour. | paint using just one

rough-edged brush, adjusting the

Dpacity and Size as | work. |

organise my brushes by using

Window>Brush Presets>Preset

Manager and then drag and drop

them into the order | want”

Separate layers: “When I'm finally
happy, | start work on the hair on a
separate layer. I've already drawn
each major section (hair, face, t-shirt,
ice cream) on a separate layer using
the Pen tool to keep the edges sharp
and to make selections quicker”

Flat colour: "Once | am happy with : - - ; — _

the overall contrast of the 5;:m.-l:.l.-. | ' Duplicate: “My final tip is to duplicate
add a flat colour layer (R253, 671, . the original sg:ﬁsc::ale shading layer
B156 for example) and change the - and set it to Light to add more
layer blending mode to Lighten at : . contrast. This way of working shaved
100% Opacity i - literally hours off my digital painting

© Wendy Stephens
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© Adam Spizak

03. USE SAVED
SELECTIONS

lllustrator and designer Adam Spizak (www.spizak.
com) saves time in his work by making the most of
the Save Selection and Load Selection commands
within Photoshop, which enable you to create
complex selections and save them for use in the
future. He explains: “When working with layers it's
often very helpful to use selections for more
precision. One of the ways to be more efficient with
selections is [to use] the functionality to quickly load
and save selections in Photoshop. Stored in the
Channels palette, saved selections are very powerful
yet often overlooked by many users.

After creating a selection you can save it from the
main menu - click on Select and choose Save
Selection. Make sure the Radio button is clicked on
New Selection, then click OK. You can name your
selection and even store selections in a separate PSD
file for various projects. You can quickly load a
selection by navigating once again to the Select
menu and choosing Load Selection.

This is an extremely efficient method [especially if
you assign] a shortcut via the Edit menu and select
Keyboard Shortcuts (Shift+Opt/ Alt+Crmd/ Ctri+K). You
can also see a list of selections from within the
Channels palette and load a selection by Crd/
Cirl-clicking on the Channels palette icon. Smart
management of your selections and channels will
save you hours of repeating the same mundane
tasks of selecting layers.”

04. USE NON-DESTRUCTIVE CROPPING

The Crop tool has been overhauled in the last
couple of years and one of the most useful
features, is the fact that you can crop your image
non-destructively, although this is not the default
setting. When you crop your photo, by default the
pixels that you get rid of are permanently deleted,
which isn't ideal if you want to restore some of the
image in the future. However, with the Crop tool

selected, look in the main Tool Options bar at the top
of your window. Untick the Delete Cropped Pixels
checkbox and the next time that you crop, then
removed pixels are saved. If you want to recover
your image at any point, then you can go back to the
Crop tool and click on your image; you will see the
original photo in the crop box so that you can
choose how much to bring back.

05. FOUR WAYS TO IMPROVE
WORKFLOW WITH PHOTOSHOP’S TOOLS

DESIGNER AND ILLUSTRATOR NICOLAS MONIN-BAROILLE (WWW.BEHANCE.NET/
UNKNOWNBEING) SHARES HIS INSIDE SECRETS FOR HAVING AN EFFECTIVE WORKFLOW

COLOUR YOUR LAYERS

“[It] sounds banal, but colouring Groups and Layers can
really help in keeping an organised file. In the long run it
also makes sense naming essential layers to find

them easily. Colouring Groups helps as you can
differentiate between adjustments and additional
Details, for example, as with any other element you use
in your work. Giving them specific colours - for me
adjustments are red and titled as ADJ - in the Layers

panel [makes everything easy to locate].”

SHORTCUTS AND CONTEXT MENUS

“It should be [a given for a designer], but | know my
shortcuts by heart because | have used them for so
long. It cuts an extreme amount of time not having to
use the menus. Also make use of the context menus
and the buttons in your Layers panel to add things
like adjustment layers quickly, without having to go
into the main menu.”

SAVE PRESETS

“Brushes and actions help a lot, but [in particular] a
preset for Adobe’s Camera Raw filter is useful. When
you're at the end and adding finishing touches, you
choose specific options that sometimes take up to ten
minutes to do. Then you realise a terrible error in your
work and fix it, having to do everything again... Saving a
preset in Camera Raw can save that time doing it again
and again. Whether it's a simple Sharpness change or
Lights/Shadows, Camera Raw offers a lot of things.”

/ LightShot

The fastest way to take a customizable screenshot
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THIRD-PARTY APPS

“Try using an app to make screenshot versions of your
artwork. | just recently discovered that using an app
like Lightshot (https://app.prntscr.com) to make
previews and fast images for web presentation
purposes (1,000px+ but less than 1,700px), takes less
time than doing numerous saves in Photoshop and
sizing down your work from a big scale. This is the best
recent workflow improvermnent |'ve experienced.”

€ Nicolas Monin-Baroille



© Harry Lee 2015

06. CLEAN BACKGROUNDS WITH SURFACE BLUR

Graphic designer Hamy Lee (www.hamrydlee.com) explains how this handy filter can help quickly

retouch product shots for use in commercial projects

The goal: “I've found cleaning
u hachqﬁuundﬂ on product
shots to be a common,
laborious task. | don't often
have access to studio-quality
lighting, but still want an
even, smooth background”

Why Surface Blur:
“Photoshop’s Surface Blur
filter does a great job of
removing unwanted marks
and softening the lighting,
but retaining gradients
and shadow details, which
[JrE\rEI'lt the image from
ooking flat"

Use the tool: “Select your
background by any means you
like - the Quick Selection tool
would be my first choice - then
choose Filter>Blur>Surface
Blur. The Radius will, of course,
depend on the size of your
image, but you can afford to be
generous with it”

07. LOCK THE TRANSPARENCY

If your work involves digital painting, then you will
know how important it is to be precise — one wrong
stroke can hamper your workflow and take up
valuable time getting nght. Graphic illusionist and
digital artist Valp, aka Maciej Hajnrich (www.valpnow.
com), has this simple solution to the problem, and it's
hidden in your Layers palette: “Hit the slash key (/) or
click Lock Transparent Pixels in the Layers palette to
speed up your digital-painting process. This simple
trick allows you to paint only on the pixels that are on
your currently selected layer. First you set up a shape
for your layer - this can just be a doodle - and then, by
locking transparency, you can add details and be sure
not to paint outside of [the] selected layer”

08. COPY CAMERA RAW SETTINGS IN BRIDGE

If you work a lot with RAW files, then you most
likely spend a lot of time processing your images in
Adobe Camera Raw before you even enter
Photoshop. When you open an image from Bridge
CC in Adobe Camera Raw, you can make as many
tweaks as you like and these are saved back to the
file in Bridge. Images that have been processed in
ACR have a symbol next to them in Bridge. When

Photography: “This ice cream
was shot for a commissioned
event poster. It was
photographed on coloured
Faper using just amounted
lashgun and ambient lighting”

Other retouches: "l used a
Content Aware Fill inthe corner
and boosted the Levels before
applying the Surface Blur for a
silky smooth background”

Larew s ey -y g
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you have your next batch of images, you might
want to make the exact same edits in ACR as you
did with a previous image. Luckily, you can copy
and apply the ACR settings to save time. Ctrl/
right-click on the original image and choose
Develop Settings>Copy Settings. Select your new
image (or even multiple new images) and do the
same, but choose Paste Settings instead.

© Valp

© Alexander Otto

09. ORGANISE YOUR
PROJECTS

As a busy art director and designer, Alexander Otto
(www.alexanderotto.com) knows the importance of
being organised to create an efficient workflow for his
professional work. "With every new update of
Photoshop, our lives as designers are made much
easier than ever before. For example, with the help of
Content-Aware, common tasks are happening
almost automatically. If you look at the internet, there
are thousands of free ready-to-go templates,
mockups and plug-ins that make you produce work
even faster,” he explains. “But for me, personally, |
have noticed the biggest improverment after |
organised and approached projects just a little bit
differently to usual. It's all about how you manage
your time day-to-day and optimise your workflows.
Break down your tasks for the day and what you
want to accomplish. Then start with working on the
biggest problems first.

“For example, compare the sketch/concept version
versus the final artwork that | did for Fotolia. In just a
few hours | had put together a quick and rough version
to see what works best. | played with the general mood
and tone, tned many different compositions and
thought about basic stuff like perspective and lightning.
It's important to distill down your ideas and then bring
in elements that help you tell your story. | kept it all
rough and dirty in the beginning, so | could easily jump
around with ideas and things | wanted to explore.”
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© Wendy Stephens

© Alexander Weaver

10. INCREASE SPEED WITH PLUG-INS

Freelance graphic designer Wendy Stephens (www.
darkirisdesign.co.uk) swears by the Painters Wheel
plug-in by Len White (http://lenwhite.com/
PaintersWheel/) to considerably improve her digital
painting speed: "l tend to paint in greyscale first and add
colour adjustment layers later, so | know the underlying
contrast is right. Picking greys using the traditional
colour picker in Photoshop can be a bit clumsy.

“In Painters Wheel, the greyscale rectangle at the
bottom currently shows four shades. If you click the

11. DO MORE IN CAMERA RAW

The Camera Raw plug-in in Photoshop CC can often
get overlooked, but it is a powerful program in its own
nght. Rather quietly, it got updated to version nine in
April 2015, which doesn't usually happen, as updates
come with Photoshop releases. Camera Raw 9
introduces two major new features, which could save
you time if you work a lot with photography and it even
takes on some of the burden that you usually use
Photoshop to manage.

St Hgted THA
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If you open multiple images in Adobe Camera Raw
(ACR) 9 (which you can do by selecting the images in
Bridge, Ctrl/right-clicking and selecting Open in
Camera Raw), then you will see a new Filmstrip view
down the left of the screen. There is a little flyout menu
at the top, which has the new features: Merge to HDR
and Merge to Panorama. Both of these tasks can be
done via Photomerge in Photoshop and certainly
Photoshop offers more options, but if you need a quick

New menu: This flyout menu gives
you the selection options that used
to sit at the top of this panel, as well

as the new Merge controls

F Filmstrip: The new Filmstrip panel

shows you all of the images that
= ——

you currently have open in ACR

Fareewra Werge S

Merge panel: ACR does all the work
for you and gives you a few options
to tweak if needed. Once you hit
okay, it will process your image,
which could take a while

Further editing: Once the merged
image is processed, you have
access to all of ACR's powerful
image-editing tools to continue
retouching as you need

little + sign on the left you get five, then click again for
six and so on. | also find the Painters Wheel itself
invaluable when choosing colour palettes. It just feels
more intuitive to me when selecting colours that
work well together. Drag the little circle on the outer
wheel to change the colour. Then drag the little circle
in the centre triangle to change the tone. As you drag,
it keeps the original colour in the top left hand
triangle, showing the new colour next to it. Brilliant
for refining colour choices.”

merge and wish to continue tweaking in ACR, then this
is a really powerful addition.

The process Is simple; select all the photos that you
want to include in the Filmstrip and pick your merge
options — ACR does the rest. There are a few
customisation options, but they are minimal. However,
once the merge is done, you have the full range of ACR
tools to tweak the new merged image to suit your
needs, before opening in Photoshop.

12. KEEP COLOURS IN ORDER WITH

THE SWATCHES PALETTE

“Whether you're designing for print or web, having
your colour swatches and palettes well organised
can help speed up your process. Finishing a project
can be difficult if you're constantly using your
Eyedropper tool or plugging in RGB values,” says
graphic designer Alexander Weaver (www.
behance.net/atweaverdesign). Alexander suggests
opening your Swatches palette and viewing all the
default swatches. You can delete any swatch by
right-clicking on it and choosing Delete Swatch from
the pop-out menu, or by dragging a swatch to the
trash. Clearing the whole palette means you can
start to build up the colours that you need for your
projects rather than seeing all of the default colours.

Alexander Weaver goes on to say, “Graphic
designers don't have to start from scratch with colour
schemes and play around for a length of time with no
clear goal. Colour schemes can be created from
something as simple as a photograph with a whole
range of hues. Often Dribbble, Pinterest, Behance and
Greyscalegorilla are a great source of colour palette
inspiration for your design.

“Now that you ve taken the time to organise your
Swatch library and clear your Default palette, maintain
the progress that has been made. Organise and name
your palettes as you're adding colour swatches. Save
your palettes and swatches to your libraries for
repeated use in the future.”



13. ADJUST A SINGLE COLOUR

MARTIN GROHS (WWW.MARTINGROHS.DE) USES THE HUE/SATURATION
ADJUSTMENT LAYER TO TARGET INDIVIDUAL COLOURS FOR EDITING

01 ADD AN ADJUSTMENT LAYER

"Here | show you how to change the
saturation of one colour in an image. | often use
this at the beginning of a painting, but | also use
this after the work is done for fine-tuning.

Create a New Adjustment Layer>Hue/Saturation.”

03 ‘ FINE-TUNE IT
“You will notice that only the chosen
colour is changed. You can fine-tune it with the

dark grey areas, making the transition more
fluid [and] softer in the same place.”

0 2 TARGETED ADJUSTMENT

"Select the small Hand tool icon. Click with
the mouse over the colour you want to change/adjust
You can see [the cursor change to a] pipette now for
you to choose the colour. Click and drag the mouse -
while holding down the mouse button - to the left or
right to adjust the saturation of this target colour.”

»
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14. MAKE USE OF QUICK VIEW OPTIONS

Not all of us have the luxury of a dual-screen
setup, so it can be frustrating when you want to
quickly change what you can see in your
Photoshop window. Luckily, there are a few
tricks that you can use to help you to navigate
around your image quickly and simply. Our top

tip is to use the H key. If you are zoomed in on
one part of your image, then you hold down H
and click with your mouse, the image will fly
back out to view the whole image in the window.
A box will appear and you can use this to
navigate to any other part of the image, where it

-

Martin Grohs
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will zoom in so you can check the detail here. When
you release the H key, you will go back to your
original view without having changed position at all
— perfect if you need to see a quick element in
another part of the image but want to continue
working as you were.
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South Coast Designs

15. CREATE MOCKUPS FOR CLIENTS

Sometimes you have to spend a little time going
the extra distance to reap the rewards in your future
workflow. Brad Marsh is the creative director at
South Coast Designs (www.southcoastdesign.
co.uk), and he says that a mock up can really help a
client understand how a project will look, rather
than a flat design: “When you're producing a work
of art for a client, simply sending them a high
resolution JPEG or PDF simply won't cut it these
days. To inspire and catch the attention of the

16. EDIT 3D FASTER

John Cathcart (www.whitebeardesign.co.uk) creates
vibrant and interesting 3D designs, and Photoshop is
an important part of his day-to-day workflow and
speeds up his common tasks. He talks us through its
uses here: “Photoshop has always been a huge player
in my digital toolkit. | utilise Photoshop heavily in my
current 3D work, using Color and Levels adjustment
layers to tweak imported art from Maxon's Cinema
4D. | use a lot of custorm-made brushes to add depth
and light effects in post-production and always finish
my pieces by adding a High Pass filter along with the
Overlay blending mode to sharpen the image up.

“I have been working primarily in 3D for the last five
years, but could not produce the work that | do without
the powerhouse abilities that Photoshop offers. If I'm

people paying your wages and putting food on
your table (if you're a freelancer like myself) you
need to take extra time when putting together your
artwork into an organised and well-presented
mockup so your clients can get a better
understanding as to what their product or design Is
going to look like as a finished item.

“Take business cards, for example. If you have
produced an amazing business card for a client,
send them your final designs set up to look like a

working on an extremely detailed render, | will export
the UV maps directly to Photoshop where | can get
down to detailing every element of my textures,
whether it be using the stock brushes and effects
provided out-of-the-box or by scanning and
photographing my own.

"One of the most crucial tips that | can offer when
working in Photoshop is to build your resource library.
Get out on the street and take photos, scan textures or
even pull them off the web (keeping in mind copyright
laws). Also, don't be afraid to experiment with your
blending modes, placing multiple layers on top of the
other and playing around with blending options, which
can produce some very exciting results, adding depth
to otherwise two-dimensional work.”

stack of business cards on their desk at work.
Show them what their business cards will look
like when they physically have them in their
hands and what their business contacts are
going to see when they're handed out at
networking events. | have gotten far more
referrals and have seen a bigger increase in
accepted designs after taking the time to put my
designs into an attractive mockup. It also means
they make great portfolio pieces too.”

© Polly Playford Design 2015

17. DON'T WRITE OFF
THE MAGIC WAND

Some tools in Photoshop are often consigned to
never being used because they have a bad reputation
for being unprofessional. However, no tool in
Photoshop should be completely disregarded, as they
are often designed to complete simple tasks in
super-fast time, which can help your workflow when
used appropriately. Polly Playford (www.polly
playford.com) is a freelance graphic designer
offering branding, web design, graphic design and
more. She uses the Magic Wand tool to make quick
selections when needed: “The Magic Wand tool saves
time when selecting coloured areas. You must make
sure that you adjust the Tolerance in the top menu
bar, as that makes a big difference to how useful that
tool is. Another handy tip: once you've selected a
colour, choose Select>Similar to select the same
colour across the whole document.”
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18. CREATE, MODIFY AND RE-USE SMART OBJECTS

Some tools in Photoshop are there to simply make the editable area, without losing control of the Smart layer and replace it with whatever you want! Save
your life easier, so it pays to know how to use them functionality. This is a really effective way of showing and return to original file to see the updated results.
in your workflow. One of these is Smart Objects, your work on a portfolio, or pitching to clients. “You can also get nice effects if you duplicate the
which can be a real timesaver. Graphic designer Ctrl/nght-click the layer you want to edit and select Smart Object layer and add layer effects such as blur,
Michael Wood (www.mwecreativedesign.co.uk) Convert to Smart Object. With this layer selected, go to then mask that layer to eait out the areas you want
explains how to get the best out of Smart Objects: Layer>Layer Mask>Reveal All, then with the Brush tool  blurred. Because you have used the same Smart
"Smart Objects are a great way to create content selected you can paint out parts of your layer with Object layer again, it will update both the onginal and
that is re-usable for future projects. Using masks black and bring parts back with white. After allthehard  duplicate when you make edits inside the smart
with Smart Objects can allow you to hide parts of work is done, you can double-click the Smart Object layer! Magic.”

19. SAVE EVERYTHING!

If your computer can hack it, then don't be afraid to or even go back to something | made 20-30
save all your work, even if you don't think you'll need minutes ago, | do not delete a lot of layers.
a particular layer - you never know when you might Especially for ightweight work, like my Fabrics

change your mind. Designer and Illustrator Nicolas series, | am left with files in between 100-400MB.
Monin-Baroille (www.behance.net/unknownbeing)  It's pretty simple: | put [unnecessary]| layers into a
is a fan of this method: “This requires a lot of space Group, even multiple Groups inside other Groups.
and makes files insanely large sometimes, so be That way | have copies of nearly every stage of
aware this is not recommended for a low-end development of the work and can revert or pick
. ©) Nicolas Monin-Baroille
computer. As | tend to change around a lot of things out important layers that | may have lost.

075



B TECHNIQUES 25 QUICK TIPS FOR PRO DESIGNERS

076

© José Paulo Reis

© Riyahd Cassiem

20. USE THE RIGHT QUICK
SELECTION METHODS

Jose Paulo Reis (www.zepaulocreation.blogspot.
co.uk) says that the best way to speed up a typical
photormanipulation or photo-editing workflow, is to
know which selection technique is right in each
situation. He uses mainly three tools in his work:

N

y Color Range: "To quickly select a

specific part of an image that is
mostly one colour, | 5|sz[1,|' goto
Select>Color Range and pick the
color | want to select. | usually
use this to select skies”

osapibEl B

Quick Selection tool: “l often
use this when | don't need a lot
of precision in my selection.
It's a quick and simple way to
select a certain area of the
image. It's a great tool!"

21. QUICKLY MODIFY ARTWORK WITH
TRANSFORM, LIQUIFY AND WARP TOOLS

FREELANCE ARTIST RIYAHD CASSIEM (WWW.RIYAHDC.WIX.COM/RIYAHD) SHOWS US
HOW HE MODIFIES CHARACTER POSES AND PROPORTIONS IN HIS WORKFLOW

THE CONCEPT

“This concept design is part of a personal project
exploring mecha design through the female form. |
used a combination of photo compositing and digital
painting technigues to create the design. Here | will go
though some tips for modifying character pose and
proportions using the various Transform tools and

filters. My main focus is to capture a readable pose to
the character design.”

LIQUIFY TOOL

“| press Cmd/Ctrl+Shift+X as a shortcut to activate the
Liquify filter. | then tweak the proportions of the
character with the Move brush, modifying the shapes of
the design. | also use the Twirl Liquify with a large
brush size placed at the centre of the joints to tweak
some angles to the pose.”

THE WARP TOOL

"l use the Liquity, Transform, Warp and Puppet Warp
tools to modify the pose and proportions of my
character design. The combination of these tools helps
to speed up workflow by spending less time
re-creating certain elements. To transform a layer |
press Cmd/Ctrl+T to active the layer’s Transform
mode. | [then] Ctri/right-click on the layer, then select
the Warp option in the drop-down menu. | warp the
image by moving sections and the borders of the
image around to accommodate the pose.”

. - .
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PUPPET WARP TOOL

"l use the Puppet Warp tool for more control when
modifying the pose of the character. | create a selection
with a Lasso tool to isolate a part of the design. | then
select the Puppet Warp function in the Edit menu to
create a temporary mesh from the selection. | place
pins to allocate joint orientations, to help when posing
a specific part of the design. Then start to pose the
character by moving the pins into place accordingly.”

:
e
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T =~ Shift+FB: "This is not exactly a selection

technique, but a selection modifier. Once

1 you have your selection ready, you may
need to tweak some details to make it
more natural. By simply clicking Shift+FB6,
| can feather my selection according to

. each situation, instead of ininq to the

. menu, which saves me a lot of time”

bt

22. USE ADVANCED
COLOR RANGE
SETTINGS FOR
SKINTONE SELECTIONS

If you work a lot at retouching portrait or beauty images,
then it is likely that you will need to make adjustments to
the model's skin —whether giving it a subtle glow or
smoothing it. It is quicker if you can treat all of the skin at
the same time, but selecting the skin in the first place
can be more time-consuming. The Color Range tool is
the perfect tool for this job, as it is designed to recognise
skintones and help you make an accurate selection.
Open your image in Photoshop and then go to Select>
Color Range. From the Select drop-down window,
choaose Skin Tones. This will now give you the option to
Detect Faces if you wish. The tool should have already
picked up skin tones in the image, but you can tweak
them with the Fuzziness slider. You can use the
Selection Preview option to view your selection on your
main document for a better view, and you can also use
Save to save your preset for future use.



23. SPEEDY SHORTCUTS

BEING ORGANISED AND USING SHORTCUTS ARE THE BEST WAYS YOU CAN IMPROVE YOUR WORKFLOW.
JOSE PAULO REIS (WWW.ZEPAULOCREATION.BLOGSPOT.C0.UK) TALKS US THROUGH HIS KEY POINTS

Change brush size: With the Brush
= tool selected (B) you can use Cmd/
= Ctrl+0pt/Alt at the same time as the
. pressure of the pen tablet (horizontal
movements) to increase and
decrease the brush size

Fast zooming: Fast zooming
Cmd/Ctrl+space bar with the
ressure of the pen tablet
horizontal movements) gets
you into the details quickly
- - * )
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- . 4 — - Label your layers: Labelling layers
-2 - 9 - o ' e > and grouping them into folders
iaey ' g e m allows for faster navigation within

: B e o e AT I SR e v L

& B whichcanbea ealtimesaver = o R T T ST

e - ; : ey St ¥ &

- B e S B S
24, USE LAYER COMPS
Visual designer Edmond Yang (www.edmond menu. Now, hide all your collapsed-related items
yang.com) swears by the Layer Comps panel to and create an opened menu state. Find your Layer
speed up his workflow for his interaction designs: Comps palette from the Window menu, hit the
“Instead of creating different layer groups, or even Create New Layer Comp button at the bottorm and
different PSD files for different versions of your name this ‘Open state’. Next, create your collapsed
Interaction designs, you can set multiple states state by hiding your opened items, bring up your
within one single file using the Layer Comps panel. Layer Comps palette and hit the same button again,
| basically tell Photoshop which layers | want to be naming it ‘Collapsed state’. Now you have two states
visible or not and this tool can be very powerful and you can switch between by using the icon to the left
save you a lot of time. of your layer comps. Remember to hit the Update

“Let's say that in your design you have two states, Layer Comp icon if you are moving or changing
one with a collapsed menu and one with an opened anything within a layer composition.”

25. CUSTOMISE YOUR WORKFLOW WITH — e

© Edmond Yang

PREFERENCES AND ACTIONS —T | TS

It's not very exciting, but by spending some admin time and see how it affects your work. Next, set up custom 3 : o

in Photoshop, setting everything up in away thatworks  shortcuts (Edit-Keyboard Shortcuts) for the tools that o T e

for you, you will significantly cut your workflow time, so you use the most, as this will save you time hunting e e Comne Loven

you can concentrate on being creative instead For a things down. Build your own Workspaces and save == H::._::__; —

start, don't be afraid to play with your Preferences. By them (Window> Workspaces) so that you have a setup S5 et

default, Photoshop is set to use 60 per cent of your for every main task that you undertake. Create actions .

computer’s RAM (Photoshop>Preferences> for common tasks and turn them into Droplets for easy

Performance). You can try upping the Memory Usageto  access. There are plenty more ways you can customise

help Photoshop run faster - start with small increments  your Photoshop experience, so start experimenting! .
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10 CELEBRATE THE
CINEMA RELEASE OF
MAD MAX: FURY ROAD,
OUR SISTER MAGAZINE
PHOTOSHOP CREATIVE
TEAMED UP WITH
WARNER BROS. PICTURES
AND MCM COMIC CON TO
CHALLENGE YOU TO
CREATE A POSTER FOR
THE FILM

Hand-picked by the director himself,
and chosen from over 50 entries, the
winning poster was created by Adam
Davison, and was displayed at the
UK's largest MCM Comic Con in
London on 22-24 May 2015. Davison
won tickets for two to Comic Con
plus an overnight stay in London for
him and a quest to enjoy the
convention, where his winning
artwork was displayed.

The film's director, George Miller,
selected the artwork as the winning
poster for being the most amresting
and original. Head to http://bit.
ly/1F3gJmD to see all of the posters
entered into the competition.
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REVIEWS EPSON EXPRESSION PHOTO XP-860

Compact but not lacking: The compact
Epson hosts a huge array of features in its
small stature




EPSON EXPRESSION
PHOTO XP-860

EPSON'S LATEST COMPACT PRINTER PACKS AN INCREDIBLE ARRAY OF FEATURES
AND A BEAUTIFUL DESIGN. BUT IS [T REALLY AS RHIGH-QUALITY AS T LOOKS?

www.epson.co.uk

s technology gallops onwards, the world

Is focusing more and more on the

internet. That's true of artists these days

who are more likely to pick up a stylus
than a paintbrush, but also of the modem-day
photographer who is more likely to spend their time
in Photoshop than in the darkroom.

Photoshop users are more likely to share their
work online than they are to print it out, but that
doesn't mean that there aren't some fantastic
printers on the market at the moment. They have to
be good too: printers will get left behind if they don't
keep up with the evolution of technology, so these
days, you're likely to see smaller printers, more

« Windows, Mac, various mobile
devices, SD card

* Printing resolution: 5,760 x 1,440 DPI
« Wireless enabled

advanced scanning resolutions, Wi-Fi connections,
and in the case of the Epson Expression Photo
XP-860, the ability to scan and print straight to and
from Facebook.

The XP-860 also looks and feels extremely
modern and very stylish. The sleek, black casing
hides the paper tray, which can be opened by
flipping up the lid of the machine, and the scanner
Is easily hidden on a separate layer.

Adding to its modern features and look, the
Epson weighs less than ten kilograms. It's a
space-saver, but as with so many small printers,
does the size compromise the more ambitious
capabilities of the XP-8607

Scanning abilities: The strlish design
hides the high-quali

ty scanner
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REVIEWS EPSON EXPRESSION PHOTO XP-860

Quality imagery: The printer produces
high quality images with near perfect
colour in just twenty-seconds

t's built for convenience too: photographers can plug their SD

cards straight into the printer, and i0S and Google device users
can print with AirPlay and Google Cloud Print respectively

Glossy, compact and featuring a touchscreen
LCD display, the Epson Expression Photo XP-860
certainly looks the business, but it also matches its
impressive look with incredible print quality. It
prints with six inks - standard CMYK with added
light magenta and light cyan — which means that if
you're an artist or designer looking to capture the
subtlest colours in your work, the XP-860 is more
than capable. The print resolution of 5760x1440 dpi
means that sharpness isn't compromised either.

The printer produces high quality images in just
20 seconds. This excellence is only to be expected
from an Epson printer, and the XP-8460 handily has
all the necessary requirements to also make it
great for office life: it can print straight onto discs, it
can fax, and it can even print double-sided.

Interestingly though, the major inconveniences of
the XP-860 for someone buying one for the office,
aren't necessarily a big deal for an artist or designer.
Six ink cartridges means a higher cost per page,

and the paper tray - as well as being somewhat fiddly

to manoeuvre — holds only 100 sheets of paper; the
top feeder on the printer (built for higher quality
paper) can hold around 20. While you may find
yourself restocking the printer more regularly than
youd like in an office, a designer will probably print
slightly less often. Not to mention that there's more
Justification for the latter, when it comes to
purchasing a printer that's expensive to run, but
unbeatable in colour quality.



As a designer’s printer, it's easy to see how the
XP-860 fits into a studio, or even a bedroom. It's a
handy size, and it looks fantastic, from an outwards-
sliding display panel when you're using the machine,
to the LCD screen itself. It's built for convenience too:
photographers can plug their SD cards straight into
the printer, and i0S and Google device users can print
with AirPlay and Google Cloud Print respectively.

But it's as much about the substance as the style:
the XP-860 is immensely powerful, thanks in part to
the cartridge set-up. It's relatively quiet, it's quick, and
the only drawback about the actual printer itself is
that it's difficult to get the paper tray in and out. It's
probably the only time that the XP-860 feels like it
could do with being a little more spacious.

The only other factor that may detract from the
beauty and power of this printer, is the price. Running six
ink cartridges might be the cost of quality, but a £250
price tag might put you off investing in one.

Take the 300-dpi scanner into consideration
though, and you have not just a printer, but a hub
for connecting real world art with the digital. If
you're going to spend that amount of money on
top drawer printer, you can't get much more for
your money than with the XP-860. Its an
impressive printer for its size, and one that's
certainly keeping up with technology.

Features: 9/10

Ease of use: 9/10
Quality of results: 9/10
Value for money: 6/10

FINAL SCORE:
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REVIEWS TEXTURE EXPORTER PRO

TEXTURE EXPORTER PRO

HAVE FULL CONTROL OVER YOUR TEXTURES LIKE NEVER BEFORE,
USING UNORTHODOX ENTERTAINMENT'S LATEST ADD-ON

xtures give your work limitless
possibilities in Photoshop and are an
integral part of most digital artists’
workflow. They inject a true realness into
your pictures and 3D models, whether you're
adding a canvas to a digital painting or using
displacement maps, so it's important to get the

www.unorthodoxentertainment.com

» Mac and PC
+» Photoshop CS5 and above

best out of them and use them wisely.

While there are lots of programs, websites and
tutorials explaining how to create your own
textures, there isn't as much help for actually
managing them. Unorthodox Entertainment’s
Texture Exporter though, as the name suggests,
Is one such piece of software that promises to cut
the amount of time you spend exporting textures,

B EXPORT TEXTURES

CHOOSE FROM A RANGE OF GROUPS TO EXPORT YOUR TEXTURES TO

B EXPORT OPTIONS

Go in-depth with every possible option for
exporting your textures, in the specific
Export Options button on the menu. Only
your visible groups show up in this layer,
which makes customising easier, and you

B GLOBAL DEFAULTS

Set global defaults for your files
to save even more time aduring
exporting. There are four custom
group settings.

can add specific suffixes to your file names
to go even further in-depth, and organise

things automatically. and avoid confusion.

B CREATE TEXTURE GROUPS
Creating texture groups is where it all
begins in Texture Exporter. You can
choose to create alpha groups, and
even RGB groups with four additional
custom texture groups. You can then
start exporting with the other options.
Name your custom groups too, to
manage everything about your textures,

as well as making it a simple and user-friendly
process. It is an extremely perceptive Photoshop
plug-in that gives the user an easy-to-use,
customisable and efficient way to manage and
export their texture maps.

Texture Exporter works similarly to an action.
It's a simple tool designed for enhancing your
workflow, and it even comes with added
tutorials that you can watch by clicking on the
Unorthodox Entertainment logo.

Begin by going to Setup, choosing your
desired resolution and then Create Texture
Groups. Texture Exporter offers eight different
group types - Diffuse, Specular, Normal,
Translucency, Gloss, Emissive, Height and
Ambient Occlusion, plus four custom options
- s0 simply check the ones you want to add to
your project, and start from there. It couldn't be
any more user-friendly, especially for the
average digital artist: the plug-in only consists of
four menu options, and it's the simplicity that's
perhaps the selling point of the software.

On from there, the Exporter Options are also
extremely simple. It feels rather like a natural
extension suited to Photoshop; you can choose
file type, whether you want to resize the texture
— a bit like the Save For Web Devices tool - and
any changes you make get stored in your PSD

Promises to cut the amount

of time you spend exporting
textures, as well as making it a
simple and user-friendly process

B TUTORIALS

Another great little extra from
Unorthodox Entertainment is that
Texture Exporter provides tutonals to
help with your use of the program.
Simply click the question mark logo,
and Texture Exporter will load your
web browser, and assist you with
YouTube tutorials relating to how to
use the add-on.



*
L
E—— 7

Exported texture: Once a texture has
been exported you can use it in your
Photoshop images

file. Export is an extremely speedy process that
offers you the option to view the file folder after
exporting, and if that's not fast enough, Quick
Export exports a texture group with any sub-layer
or group selected. The one-click, artist friendly
export process helps to eliminate any errors
without compromising any control. The option to
export multiple texture groups all at once is
another great feature.

It's not a particularly flashy program, but Texture
Exporter Pro is a great time-saver, and well worth
$30, especially if you're someone who relies on
textures a lot in your work. There is an Indie version

of the software too, which is just $15, but it omits the
ability to edit script files, along with some of the
error-checking and organisational capabilities. The
Pro version comes with a commercial license and
no pop-up delay or texture map size imitations on
export. A further nice touch from Unorthodox
Entertainment’s Texture Exporter, is that you get free
updates for life.

It might not boast a wealth of features, but that
doesn't make it any less powerful. Texture Exporter
does exactly what it was designed for, and does that
extremely well. It will benefit any artist greatly as it
will help to streamline their workflow.

Features: 7/10

Ease of use: 8/10
Quality of results: 9/10
Value for money: 8/10

FINAL SCORE:

A neat tool for anyone who wants to
export textures quickly and cleanly,
Texture Exporter is a must-have
add-on for 3D users
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B READER INTERVIEW DREAMING OF DROIDS

DREAMING OF DROIDS

DISCOVER WHAT FIRES UP THE IMAGINATION
OF CONCEPT ARTIST RIYAHD CASSIEM

n early love of sci-fi inspired South African
Riyahd Casseim to become a concept artist.
We caught up with him to discover how
Photoshop has helped him on his creative
journey, and how his style and approach has changed
and developed throughout his career so far.

visual effects in the films like Aliens, Predator and Blade
Runner, as well as well as graphic novels like Heavy
Metal, 2000 AD, X-Men, Spawn, and Batman. | was then
committed to [the] idea of learmning as much as | could
about the production process of creating characters and
environments, to be able to one day create my own

therme and graphic concepts.
WHERE DID YOUR LOVE OF SCi-FI COME FROM? OUR READER
limmersed myself in art, film, and books at an earlyage. WHAT'S A TYPICAL WORK DAY FOR YOU? RIYAHD CASSIEM
| was constantly drawing and exploring different | work as a independent freelance digital artist doing www.riyahdc.wix.comy/ryahd
@Riyahd_Cassiern

mediumns, from pencil and paper to painting on canvas.
With support of my mother and influence from my
father, | was introduced to science fiction and fantasy
authors such as Jules Verne, Arthur C Clark and Edgar
Rice Burroughs. My fascination grew with the art and

g -
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visual effects, motion graphics, digital sculpting,
illustration and concept art. | usually work at night, |
spend the first hour or so working out what work needs
to be done, checking messages, re-evaluating previous
work and so on. | then break down the work into
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Aurielia: “Life drawing, ar}ﬂnmv. compaosition,
form, tone, texture and colowr,” are all
important, adds Cassiem. “Try to learn how to
emulate how light affects shapes and different
materials. There is a lot to be learned b
studying the Old Masters for fundamentals®

Amiya: "Have a solid foundation in the
fundamental principles of art and design, if you
want to make it as a digital artist, advises Lassiem
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‘ ‘ | have followed my childhood passion of wanting
Security droid: “The industry does require.you

to create sci-fi and fantasy art, creating
sl  ©N\vironMments, characters, creatures and robots 79

to have a thick skin, and being able to learn from




| constantly sketch in my sketchbooks
“ between working digitally and often let
those sketches inspire the digital workflow
and vice versa. | find working in digital allows

for a kind of creative freedom to explore
different ideas and techniques 7

gates a more unique aj
s, says Cassiem, who
stoshop to good effect




THEN AND NOW

"My favourite image right now is my recent
Sentient artwork | created of a meditating

female mech,” says Cassiem. ‘It is part of a

personal project about sentient machines finding
a spiritual connection (inspired by Ghost in the
Shell), while trying to explore design forms of
the human body with a mech design influence.

segmented tasks and dedicate the time to the specific
tasks, or | just go with the flow and act on inspiration.
Most of these images were created with no specific
brief from any source, but were a collection of my
current moods and state of mind over the last few
years. | drew the images from experience in my
day-to-day life, whether it be from my environment or
partially subconsaous thoughts. | have followed my
childhood passion of wanting to create sci-fiand
fantasy art, creating environments, characters,
creatures and robots. It's that passion that's gotten me
where | am and it's the passion that drives me forward
into the future. The feeling of wanting to create

IR AN

DREAMING OF DROIDS READER INTERVIEW B

| also use this image as my current desktop
wallpaper and look at it when | am feeling
stressed or uninspired to remind me to just
breathe and meditate on what I'm doing.” Senika
Is one of Cassiem’s earlier works, and it
demonstrates that the most challenging part of
his career was “that transition phase from

something and trying to create it keeps me going.

WHEN DID YOU START USING PHOTOSHOP?
| first started experimenting in Photoshop with a
mouse | think in 2004, trying to transition from
traditional to digital using a comic book approach of
scanning an artwork then using Photoshop for digital
colouring. It soon became apparent that | needed a
stylus to paint digitally. At the same time | started
experimenting with different applications like Maya,
After Effects and later Zbrush and Keyshot, which |
now incorporate into my curent workflows
depending on the project | am working on.

ﬁ

SENIK A

traditional to digital, trying to emulate the
traditional look digitally, where now | have
accepted and embraced the look of digital and
nhow varied it can be. | am constantly trying to
evolve my workflow with the technology while
still retaining my passion for traditional art
and principles.”

N

WHEN DID YOU BEGIN WORKING AS A PRO?

| got my first job after finishing Midrand Graduate
Institute. | got a bursary from a graphic design
agency, which required me to work at a studio for a
few months before getting a position as a VFX artist
at a film and commercial production company, where
| was doing storyboards, design, concept art, matte
painting, motion graphics and visual effects and
learning the different visual production processes.

WHAT'S YOUR FAVOURITE PHOTOSHOP
TOOL?

My favourite tools are the Brush tools in Photoshop
for digital painting and the adjustment layers to
adjust various colours and values to the image
accordingly. | also use the layer blending modes
extensively for different overlay effects. Another
favourite of mine is some of the image
manipulation tools like Liquify, Puppet Warp,
Content Aware and Transform Warp.

WHAT DOES YOUR WORKFLOW INVOLVE?

| still have a passion and appreciation for traditional
art and mediums, from the Old Master painters and
sculptors. | constantly sketch in my sketchbooks
between working digitally and often let those
sketches inspire the digital workflow and vice versa. |
find working in digital allows for a kind of creative
freedomn to explore different ideas and techniques.
Being able to create a relatively detailed conceptin a
short period of time, with the ability to do variations,
adding motion and working in 3D space, to viewing
the design in the real world as a 3D print, creates an
added dimension to my creative workflow, with
different possible outcomes.
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Paper: You ll need paper specifically
for watercolour. It's strong and has
a texture that absorbs the water
and won't crinkle

Masking fluid: Apply it to areas of
the paper before painting it. Once
it's dry you can paint over it then
remove it, leaving clean paper

-

Paint: Watercolour paints come
in a variety of colours and prices.
Brush: You'll need a brush , ' Even affordable paints will work
specifically for watercolours. for this tutorial
It holds more water than
regular paintbrushes and
spreads paint evenly




CREATE YOUR OWN CUSTOM WATERCOLOURS ON FILESILO

CREATE YOUR OWN
CUSTOM WATERCOLOURS

EARN HOW TO MAKE WATERCOLOUR BRUSHES FOR TRADITIONAL ART EFFECTS

atercolour art has been around for sketches before larger paintings in other mediums. IS pretty cheap; once you have the supplies you can
centuries. It is characterised by Today, the unpredictability and vibrancy of the paints make hundreds of brushes, textures and designs to
transparent colour that can be layered make it fun for both children and adults. But it is also fit all of your design project needs. It's also relatively
when dry or blended while wet. useful for designers. simple and a great way to incorporate other
Watercolour is considered the medium used in Watercolour brushes and textures can add a mediums in your work. Using watercolour in design
Palaeolithic cave paintings. It was a prominent splash of colour, and rich texture that gives a provides a unigue opportunity to blur the lines of
medium during the Renaissance for studies and handmade effect to digital projects. Also, this project  digital and traditional in a classy and elegant way.

BASIC WATERCOLOUR WASHES

0 1 LOAD UP YOUR PAINTBRUSH 03 CAPTURE YOUR ART

Load your brush with the colour of your 0 UNLEASH YOUR INNER ARTIST Wait for the paint to dry completely.
choice. Use a colour that is dark enough to scan Paint spots of colour all over your paper. Then either photograph or scan them for use in
well with enough contrast. Avoid yellow. Experiment with size, amount of water, drips, Photoshop. Make sure the spots you've painted
Experiment with the colours to make sure you have splatters, and a drier brush. You may need to tape don't bleed into each other if they move during
the right water to colour ratio for a smooth effect. the paper to a board to prevent warping. the drying process.

WATERCOLOUR WASHES WITH MASKING FLUID

* -

e i
= \ T
01 APPLY THE MASKING FLUID S

Using a cheap brush, paint the masking 0 PAINT WITH THE WATERCOLOURS 03 PEEL THE MASKING FLUID OFF
fluid on the paper however you want. Remnember Once the fluid is dry, use the watercolour to Once the paint is dry, peel the masking

that wherever you paint the masking fluid will be paint over the areas you want. Don't worry about fluid off. Just rub it with your finger until it peels
white after you paint with watercolour over it. Make painting on the masking fluid, that's why it's there. off, be careful that you don't rip the paper off as
sure to let it dry completely before painting. Allow the paint to dry completely before the nextstep.  well. Then photograph or scan your new designs.
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create fun new effects for your brushes and textures. Here | am going to
be using alcohol, salt, plastic wrap, and multiple watercolour colours.

WATERCOLOUR TECHNIQUES

By combining standard watercolours with household ingredients, you can

Alcc:hnl Whm: your paint is still wet, drip
small drops of isopropyl alcohol into the '
paint. The paint will spread away from it

and create interesting ring patterns

I
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Plastic Wrap: While your paint is wet,

crumple some plastic wrap and lay it over

top of the paint. Let the paint dry before
removing it for a cool rock-like texture

Salt: While your paint is still wet
sprinkle salt on it. Coarse salt will
leave larger spots and fine grain
salt will leave smaller spots

Colour Dropping: Drop one colour
of paint into another colour while

the paint is still wet; try with multiple
colours and different size drops




CREATE YOUR OWN CUSTOM WATERCOLOURS ON FILESILO

DIGITAL WATERCOLOUR

Creating traditional watercolour effects is digital brushes can bridge this divide to help
something that is usually reserved for painting you to create realistic paintings.

with practical materials only. Digital mediums The proper technique doesn't use the brushes
struggle to simulate the fluid movements of the as one might normally expect. Dragging the
liquid and the results often lack the familiar cursor will not provide good results. It's all about
appearance of traditional watercolours. But the single clicks, so the brushes are used more
using the classic watercolour strokes to create like a stamp than a brush. Blending modes play

another major factor in creating the effect, both
at the layer level and on the brush properties.
There’s no better way to mix various paint
colours in Photoshop than with blending modes!
Check out the video tutorial for this project to
see exactly how this image was created using
the brushes provided in the resources project.
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ON FILESILO CREATE YOUR OWN CUSTOM WATERCOLOURS

TURNING WATERCOLOUR INTO BRUSHES

> e
sl
w0 o
J) &2 ¢ W

: L
ARGE CC ON OF BR
U 1 DESATURATE THE IMAGE
Once you open the image and crop it so 0 ADJUST THE LEVELS
your desired colour spot is isolated, desaturate the Next adjust the levels so the whites are pure
image. Do this by opening the Hue/Saturation white. Do this by moving the left slider in the Levels :
dialogue box and pulling the saturation all the way dialogue box. Be aware that the way the image looks o
down so it's black-and-white. at this point is the way the brush will look. 1 |
f.-' L
4
i - ' . -
: -
REAT CO ON OF WATERCOLOUR
RES ANU S10

03 DEFINE THE BRUSH

Under the Edit menu, choose Define
Brush Preset and name it something easy to
remember, for example; WatercolourBrush1. Now
you can use the brushes for anything you want.
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Series

Discover more with the Book series’ expert, accessible tutorials for
photography, 3D art, Photoshop, web design and more

BUY YOUR COPY TODAY

Print edition available at www.imagineshop.co.uk
Digital edition available at www.greatdigitalmags.com

ollowing platforms
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ﬂ facebook.com/ImagineBookazines , twitter.com/Books_Imagine
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RESOURCES | FILESILO

YOUR 7= RESOURCES

LOG IN TO WWW.FILESILO.CO.UK/ADVANCEDPHOTOSHOP AND
DOWNLOAD YOUR FANTASTIC PHOTOSHOP RESOURCES NOW

CREATIVE
RESOURCES

ON FILESILO THIS ISSUE, FREE AND
EXCLUSIVE FOR ADVANCED PHOTOSHOP
READERS, YOU'LL FIND RESOURCES
WORTH $142, INCLUDING...

B 25 blurred backgrounds worth $19
M 80 large bokeh brushes worth $5
B Sunshine patterns worth $12

B Video tutorials on watercolour effects and
painting over 3D renders

B Dispersion action worth $3

B Fonts worth a total of $81

B All tutorial files for this issue

EXPERT TUTORIALS S @ &

DEEQAN(!
$142 TILEABLE‘PATI'ERNS
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'FILESILO - THE HOME OF PRO RESOURCES

9 Arapidly growing library 9 No morebrokenaiscs

9 Updated continually with cool resources 9 Print subscribers get all the content
9 Letsyou keep your downloads organised 9 Digital magazine owners get all the content too!
9 Browseandaccess your contentfromanywhere  § Eachissues content s free with your magazine

i

9 Nomoretorndiscpagestoruinyourmagazines 9 Secure online access to your free resources

This is the new FileSilo site that replaces
your disc. You'll find it by visiting the link on
the following page.

The first time you use FileSilo you'll need to
register. After that, you can use the email
address and password you provided to log in.

va l.

B FEATURED CONTENT

The most popular downloads are shown in
the carousel here, so check out what your
fellow readers are enjoying!

If you're looking for a particular type of
content like brushes or fonts, use the filters
here to refine your search.

AEReYTYPE | (suses) Cooues) (Cwooe) (o DRECTEORCED Can’t find the resource you're looking for in
these filters? Click on More Types to specify
exactly what kind of resource you want.

Green open padlocks show the issues you
have accessed. Red closed padlocks show
the ones you need to buy or unlock.

- Top Downloads are listed here, so you can
Crmats you swn Linocus preyect get an instant look at the most popular
PO p——— downloaded content.

i el PRt RaD DrUAFE

Check out the Highest Rated list to see the

resources that other readers have voted for
as the best!

] 2% weamer Protanep brastes Find out more about our online stores, and
useful FAQs like our cookie and privacy
policies and contact details.

Discover our amazing sister magazines and
the wealth of content and information that
they provide.
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RESOURCES | FILESILO

HOW TO USE

EVERY THING YOU NEED TO KNOW ABOUT

ACCESSING YOUR NEW DIGITAL REPOSITORY |_ﬂl

To access FileSilo, please visit www.filesilo.co.uk/advancedphotoshop

0 ’] Follow the 0 2 f youre aprint O 3 You can access O 4 IFyou have any
INstructions subscriber, you FileSilo onany problems with
on-screentocreate an can easily unlock all the desktop, tablet or accessing content on
account with our secure contentbyenteringyour ~ smartphone device FileSilo, orwith the
FileSilo system, then log In unique Web ID. Your using any popular registration process, take a
and unlock the issue by Web ID is the eight-digit browser (suchas Safari, look atthe FAQs online or
answeringasimple alphanumeric code Firefox or Google emall filesilohelp®
question about printed above your Chrome). However, we imagine-publishing.co.uk.
the magazine. address details onthe recommend that you use — -
You canaccess mailing labels of your a desktop to download P S p-p—
plenty of subscription copies. It content, as you may not “ '
content for free canalsobe foundon be able to download files
with the Issue. your renewal letters. toyour phone or tablet.

Dispersion
Action

NEED HELP WITH
THE TUTORIALS?

Having trouble with any of the techniques in this issue’s tutorials? Don't know how to make the :
best use of your free resources? Want to have your work critiqued by those in the know? Then why 5E aFrw
not visit the Advanced Photoshop Facebook page for all your questions, concerns and qualms. * e

There is a friendly community of fellow Photoshop users to help you out, as well as regular posts ;
and updates from the magazine team. Like us today and start chatting!

Issue 137 of PHOTOSHOP is on sale from GreatDigitalMags.com



AKVIS Neon

low Lines Effects! Photoshop Plugin for Windows & Mac

akvis.com



BEAUTY RETOUCH & PIXEL JUGGLER

Retouching Academy Photoshop ane

Convenience, Speed & Style

e Digital Product, Instant Download

e 22-page PDF User Manual

e 9 Video Tutorials + More Coming

e Step-by-step Installation Video

e [FREE Pixel Juggler Panel

e FAQ, Support & Updates

e Social Media #RAPANELS Sharing

e You Keep Full Control of Your Creative Choices

e Save lime. Get More Done. Play More!

Fire Up Your Retouching Workflow

The Beauty Retouch Workflow Accelerator is a Photoshop extension that is
helping thousands of photographers and retouchers worldwide speed up and
organize their Beauty, Fashion & Portrait retouching workflows.

L ] Ll

L] iy L)

Create In Style

Declutter your workspace & close out unnecessary Photoshop panels. Let the
RA panels streamline the tedious and repetitive parts of your routine, so you
can focus on the exciting part of your creative work.

|

| earn From QOur Video Tutorials

The RA panels combine advanced retouching technique scripts with basic
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tool and adjustment layer shortcuts. Learn how to use these extensions to

save hours of work and achieve accurate, repeatabile, top-quality resuits

E®

Available for Adobe Photoshop CS6 & CC, Mac OS X & Win

"Digital download, no physical product will be shipped

flnlf .:":u‘u' f s Un L’] RETOUCHI”G More about RA panels:
INSTAGRAM  &_JACADEMY retouchingacademylab.com

for daily inspiration

Retouching Academy Los Angeles, CA www.retouchingacademy.com facebook.com/retouchingacademy instagram.com/retouchingacademy
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